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Introduction1

Essential safety precautions and an overview of the printer's main features, components, software 
options and printing possibilities.

Safety precautions
Ensure proper use of the printer to prevent it from being damaged.

Follow these precautions at all times:

● Use the power supply voltage specified on the label. Avoid overloading the printer's electrical outlet 
with multiple devices

● Do not disassemble or repair the printer yourself. Contact your local HP Service Representative for 
service, see HP Support Center on page 168

● Use only the electrical cord supplied by HP with the printer. Do not damage, cut, or repair the power 
cord. A damaged power cord can cause fire or electric shock. Replace a damaged power cord with 
an HP-approved power cord

● Do not operate the printer with covers bypassed

● Beware that a paper roll does not drop onto your feet or trap your hand and fingers during the paper 
roll load/unload process

● Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of 
the printer. Doing so may cause fire, electric shock, or other serious hazards

● Power off the printer and unplug the power cord from the power outlet in any of the following cases:

● When placing your hands inside the printer

● If there is smoke or an unusual smell coming from the printer

● If the printer is making an unusual noise not heard during normal operation

● A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal 
parts of the printer

● During an electrical storm (thunder and lightning)

● During a power failure

● To avoid being pinched, keep your fingers away from the gap between the bottom of the printer 
and the stand while you're moving the printer with stand
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● Before servicing the printer

Using this guide
This guide can be downloaded from the HP Support Center.

Introduction
This is a brief introduction to the printer and its documentation for new users.

Use and maintenance
To help you carry out normal printer procedures.

Topics include the following:

● Connecting the printer on page 11

● Setting up the printer on page 15

● Paper handling on page 22

● Printing on page 35

● Mobile printing on page 42

● Practical printing examples on page 72

● Handling ink cartridges and printhead on page 82

● Maintaining the printer on page 85

Troubleshooting
To help you solve problems that may occur while printing.

Included are the following topics:

● Troubleshooting paper issues on page 102

● Troubleshooting print-quality issues on page 116

● Troubleshooting ink cartridge and printhead issues on page 151

● Troubleshooting data communication issues on page 153

● Troubleshooting general printer issues on page 160

● Text messages and numerical error codes on page 163

Accessories, support and specifications
Reference information, including customer care, the printer specifications, and part numbers for paper 
types, ink supplies, and accessories.

Accessories on page 99, HP Customer Care on page 168, and Printer specifications on page 172.
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Glossary
The glossary contains definitions of printing and HP terms used in this documentation.

Glossary on page 176.

Index
In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and cautions
Symbols are used in this manual to ensure the proper use of the printer and to prevent the printer from 
being damaged.

Follow the instructions marked with these symbols:

WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal 
injury or death.

CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal 
injury or damage to the printer.

Printer models
The user guide covers the following printer models.

Printer models

Full name

HP DesignJet T850 36-in Printer

HP DesignJet T850 36-in MFP

HP DesignJet T950 36-in Printer & HP DesignJet XT950 36-in Printer

HP DesignJet T950 36-in MFP & HP DesignJet XT950 36-in MFP

NOTE: The images appearing in this user guide may not look the same as the printer you have. In 
some regions, exact naming may vary.

Main features
HP DesignJet T850 Printer Series and HP DesignJet T950 Printer Series are four color inkjet printers, 
designed to deliver CAD / Construction drawings as well as high quality graphics.

Paper up to 914 mm (36 in) wide can be used to print on. Some major features of the printer are shown 
below:

● Print resolution of up to 2400 × 1200 dpi using the Best print-quality option, the Maximum Detail 
option and photo paper

● The printer can be controlled from its control panel, from a remote computer using the Embedded 
Web Server.
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● Handles roll and cut-sheet paper, with a tray which automatically switches between both

● Touch-sensitive control panel in color, with an intuitive graphical user interface

● Includes Web-connected features such as automatic firmware upgrades

● Supports remote printing from mobile devices with HP App, see the HP website at the following link:

– You can obtain the latest iOS version from the Apple iTunes website at: 
https://itunes.apple.com/app/id469284907

– You can obtain the latest Android version from the Google Store website at: 
https://play.google.com/store/apps/details?id=com.hp.printercontrol

● Economode for printing economically

● Enables easy printing from desktop with HP Click, see the HP website at the following link: 
https://www.hp.com/go/clickDesignJet

● Ink and paper usage information available from the Embedded Web Server, see Access the 
Embedded Web Server on page 15

● Access to the online HP Support Center, see HP Support Center on page 168

● HP Support Assistant supports the printer, see HP Support Assistant on page 97

Main components
Hardware features of your printer.

Front view (T850)
Overview of the front of the printer's main hardware components.

1. Tray

2. Roll

3. Control panel

4. Cutter
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5. Main door

6. Stand and bin

7. Ink cartridges

8. Printhead access door

9. Printhead carriage

10. Scanner (only MFP models)

Front view (T950)
Overview of the front of the printer's main hardware components.

1. Roll

2. Scanner (only MFP models)

3. Hi-speed USB host port

4. Control panel

5. Cutter

6. Main door

7. Ink cartridges

8. Printhead

9. Printhead carriage

10. Cut sheet tray

11. Sheet organizer

12. Large format stacker

Rear view (T850 and T950)
Overview of rear of the printer's main hardware components.
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1. Fast Ethernet port, to connect to a network

2. Power cable

Turn the printer on and off
The power key is located next to the control panel.

The power key is illuminated when the printer is on, or in sleep mode.

However, if you plan to store the printer for a long period or the power key does not seem to work, you are 
recommended to unplug the power cord.

To turn it back on, plug in the power cord.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the 
printhead.

NOTE: When the printer has not been used for a certain period of time (the default time is determined 
by Energy Star), it saves power by going into sleep mode. However, any interaction with the printer's 
control-panel display, or sending a new job to print, returns it to active mode, and it can resume printing 
immediately. To change the sleep mode time, see Set the Sleep Mode setting on page 16.

Control panel
The control panel is a touch-sensitive screen with a graphical user interface located on the front left of 
the printer.

The control panel gives you complete control of your printer. From it you can print, view information 
about the printer, change printer settings, perform calibrations and tests etc. It also displays alerts 
(warning and error messages) when necessary. The following sections with diagrams and lists provide a 
quick reference to the main features. Choose your printer model from the following: HP DesignJet T850 
on page 6, HP DesignJet T950 on page 7, or HP DesignJet T850/T950 MFP on page 8.

HP DesignJet T850
The control panel lets you access printer funtionalities, check status, monitor and manage current and 
scheduled printer tasks.
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1. Status center: Swipe down at the top of the screen to open.

2. Home screen icons:

● Menu icon 

● Supplies icon 

● Paper icon 

● Jobs icon 

3. Others:

● Go back icon 

● Home icon 

HP DesignJet T950
The control panel lets you access printer funtionalities, check status, monitor and manage current and 
scheduled printer tasks.

1. Status center: Swipe down at the top of the screen to open.

2. Home screen icons:

● Menu icon 

● Supplies icon 

● Paper icon 
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● Jobs icon 

HP DesignJet T850/T950 MFP
The control panel lets you access printer funtionalities, check status, monitor and manage current and 
scheduled printer tasks.

1. Status center: Swipe down at the top of the screen to open.

2. Home widgets:

● Copy

● Scan

3. Home screen icons:

● Menu icon 

● Scan icon 

● Copy icon 

● Supplies icon 

● Paper icon 

● Jobs icon 

Printer solutions
Drivers and other tools are provided with your printer to raster, review, print locally/remotely, and access 
support if required.

The following software is available for your printer at the HP website at the following link (depending on 
printer model):

● HP DesignJet T850: https://www.hp.com/go/DesignJetT850/software

● HP DesignJet T850MFP: https://www.hp.com/go/DesignJetT850MFP/software

● HP DesignJet T950 and HP DesignJet XT950: https://www.hp.com/go/DesignJetT950/software

● HP DesignJet T950MFP and HP DesignJet XT950MFP: 
https://www.hp.com/go/DesignJetT950MFP/software
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Software content

● HP Click application for Windows 10 or newer and Mac OS, which provide access to easy printing 
with real preview

Drivers:

1. Windows V4 PCL3 driver.

2. Mac print driver.

● HP app for Windows, Android, MacOS, and iOS, which offers mobile printing and monitoring features

● The Embedded Web Server that allows you to manage the printer from a remote computer, update 
the printer's firmware and change various printer settings, etc.

See Access the Embedded Web Server on page 15.

NOTE: New versions of all printer software can be expected to appear from time to time. In some 
cases, when you receive your printer there may already be later versions available on HP's website of 
some of the software provided with it.

Mobile printing
With HP Mobile Printing Solutions, you can print straight from your phone or tablet in just a few simple 
steps wherever you are using your mobile device OS.

● HP app enhances your printing capabilities and enables scanning and sharing from your phone or 
tablet.

– You can obtain the latest iOS version from the Apple iTunes website at: 
https://itunes.apple.com/app/id469284907

– You can obtain the latest Android version from the Google Store website at: 
https://play.google.com/store/apps/details?id=com.hp.printercontrol
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● Apple iOS printing is enabled through AirPrint, which comes pre-installed in iOS devices

● For ChromeOS printing

– You can use the Chrome Native Print system, which comes pre-installed in ChromeOS devices.

● For Android printing

– Install the HP Print Service app. If you have already installed it, check that it is 
up to date. You can obtain the latest version from the Google Play website at: 
https://play.google.com/store/apps/details?id=com.hp.android.printservice

– Alternatively, you can install Mopria Print Service Plugin. You can 
obtain the latest version from the Google Play website at: 
https://play.google.com/store/apps/details?id=org.mopria.printplugin

– You can also print using the Android Default Print Service, which comes preinstalled in Android 
devices

For more information, visit the HP website at: http://www.hp.com/go/designjetmobility.

Reports
The internal prints give various kinds of information about your printer. They can be requested from the 
control panel.

Before requesting any internal print, check that the printer and the paper are ready for printing. The 
loaded paper should be at least A4 portrait—210 mm (8.27 in) wide—otherwise the print may be clipped.

NOTE: For U.S. and other countries that don't use ISO sizes; Letter is the required paper size for 
reports. Reports are generated in A4 or letter depending on the selected country.

To print any internal print, tap the Menu icon , then Tools > Reports, then select the internal print you 
want. These are some of the prints available:

● Demo Pages

● Status Reports

● Connectivity, Printer Status Report, etc.

● Usage Report

– This report is not printable and can only be viewed on the control panel

● Event Log

NOTE: Reports can also be printed from the Embedded Web Server or downloaded as a PDF; go to 
Support Tools > Reports and Pages.
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Connecting the printer2

Printing has never been easier, and your printer comes with various options for connecting to help you 
do so.

With HP Smart Admin (see the HP website at the following link: https://admin.hpsmart.com/) or HP 
Command Center (see the HP website at the following link: https://hp-commandcenter.com/), you have 
a remote view to manage printers, users, and solutions, which allows you to stay on top of your team to 
keep your company up and running smoothly.

Choose which connection method to use
Your printer can be connected via Wireless or Gigabit Ethernet.

Connectivity methods

Step 1: Connect the printer to your network

Use the control panel to choose one of these options:

● Connect to Ethernet:

– If printer is new, connect the Ethernet cable before turning it on

● Connect to Wi-Fi:

– If the printer is new, just follow the steps in the control panel

– Printer and device (e.g., desktop, PC, laptop, mobile) must be connected to the same Wi-Fi

Step 2: Set up your device

a) Connect the printer to the HP ecosystem

During the printer setup, after performing the network configuration and accepting that printer will 
connect to the internet, the printer retrieves the pin pairing code and displays it along with the portal 
URL. Follow the instructions on the control panel.

In case the printer onboarding is skipped, you can pair your printer manually; access the embedded web 
server (EWS), then go to Connected Printing > Printer Pairing.

NOTE: You may be asked to type the administration password.

1. Tap Start Pairing to begin pin pairing.

Connecting the printer 11
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You can see the progress in the window that appears:

2. The process asks you to check the control panel to retrieve and enter the pairing code. It also 
indicates which URL you should type in the browser to continue the onboarding process.
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3. Once the process has completed and the printer is paired, the following message is displayed:

Printer and devices must be connected to the same network.

If required you can find your printer's IP by scrolling down from the top of the screen.

● – Go to the support page for your printer series on the HP website at the following link (depending 
on printer model):

○ HP DesignJet T850: https://www.hp.com/go/DesignJetT850/support

○ HP DesignJet T850MFP: https://www.hp.com/go/DesignJetT850MFP/support

○ HP DesignJet T950 and HP DesignJet XT950: 
https://www.hp.com/go/DesignJetT950/support

○ HP DesignJet T950MFP and HP DesignJet XT950MFP: 
https://www.hp.com/go/DesignJetT950MFP/support

NOTE: If you connect an Ethernet cable, it turns off the wireless capability of the printer.

NOTE: Wireless connections can be affected by the location of the network router and the device. In 
order to improve a wireless connection:

1. Position the wireless access point in a more central position within the work place.

2. Place the wireless access point away from dense materials. Metal, concrete, double thick walls are 
the hardest to penetrate, wood and plasterboard are easier. Consider this when you position the 
printer.
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3. Change the wireless channel to one that is not being used. Preferably 1, 6, or 11, as these are 
non-overlapping channels.

4. Extend the range of the wireless network with the use of a simple wireless extender or add more 
wireless access points.

Set up your device
Prepare your printer with the correct software for your device.

Install the software (Windows)
Make sure to connect the printer and computer or mobile device to the same network.

To download the software, see Printer solutions on page 8.

Install the software (Mac OS X)
Make sure to connect the printer and computer or mobile device to the same network.

To download the software, see Printer solutions on page 8.

Add your printer
Add a printer to a network under Mac OS X.

■ Go to System Preferences > Printers and Scanners, and then tap + to add a new printer.

● If you installed the driver: Select the IP tab, enter your IP address, and select the protocol HP 
Jetdirect-Socket. Tap Continue.

● If you want to use AirPrint: Choose your printer from the list of displayed network printers, and 
tap Add. Then, in the Use menu, select Secure AirPrint or AirPrint, and then tap Add.

TIP: To see the bonjour name on the control panel, open the printer's dashboard and tap the Menu 
icon , then Settings > Network > Ethernet > Ethernet Details, or Settings > Network > WiFi > Wi-Fi 
Details.

14 Chapter 2  Connecting the printer



Setting up the printer3

Introduction
There are various printer settings that the printer administrator may wish to control as soon as a new 
printer is assembled and ready for use.

Accessibility
To ensure accessibility to the operating area, it is recommended to have an even-leveled clear space of 
minimum 760 mm (30 inches) by 1220 mm (48 inches).

Change the language of the control-panel display
Your printer includes many language options to choose from.

To change the language of the control-panel menus and messages:

If you can understand the current control-panel display language, tap the Menu icon , then 

Settings , then General > Display > Language. Select your preferred language.

Access the Embedded Web Server
Manage your printer remotely using an ordinary web browser running on any computer.

To access the Embedded Web Server on any computer, open your Web browser and type the IP address 
of your printer.

You can see your printer's IP address on the control panel when you open the Status Center.

To access the Embedded Web Server, the printer requests your Admin PIN to prevent unauthorized 
users from remotely configuring the printer, or viewing printer settings. The PIN is required to change or 
view printer settings. By default the user is admin. The PIN is found behind the printer.
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You can print the printer status report, go to Menu > Tools > Reports > Status Reports, the tap Print.

NOTE: The status report has the PIN. If your changed the initial PIN by default and forgot it, go to 
Troubleshooting general printer issues on page 160.

The following browsers are known to be compatible with the Embedded Web Server:

● Microsoft Edge (latest version)

● Apple Safari 15 or later for OS X 10.15 and later

● Mozilla Firefox (latest version)

● Google Chrome (latest version)

If you have followed these instructions but failed to get through to the Embedded Web Server, see 
Cannot access the Embedded Web Server on page 161.

Change the language of the Embedded Web Server
The default language is the same as your browser but if it is not supported, it will appear in English. You 
can change it to any supported one.

Embedded Web Server supported languages are English, Portuguese, Catalan, Spanish, French, Italian, 
German, Polish, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese. There is a tab at 
the bottom left of the window to select them from.

Automatic firmware update
The printer can automatically check for a firmware update periodically.

Set Windows driver preferences
You can change some default settings in your printer driver according to your own preferences, for 
instance to set color or paper-saving options.

To change default settings, click the Start or Search button on your computer’s screen (depending on 
your version of Windows), then click Devices and Settings, Devices and printers or Print Management. 
Then right-click your printer's icon and click Printing preferences or Set Printing Defaults. Any settings 
you change in the Printing Preferences window will be saved as default values for the current user.

To set the default values for all the users of your system, right-click the printer’s icon again, click Printer 
Properties, go to the Advanced tab, and click Printing Defaults. Any settings you change in the Printing 
Defaults window will be saved for all users.

Energy-conservation settings
Learn about the energy-conservation settings that are available on your printer.

Set the Sleep Mode setting
Use the control panel menus to specify the amount of time the printer must be inactive before it goes 
into sleep mode.
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1. From the home screen on the printer control panel, tap the Menu icon , then Settings .

2. Scroll to and open the following menus: General > Energy > Sleep.

3. Tap an option to specify the amount of time the printer must be inactive before it goes into sleep 
mode.

4. When you are finished, tap the Back arrow button to return to the General settings menu, or tap the 
Home button to return to the home screen.

NOTE: You can perform the same operation from the Embedded Web Server by going to General > 
Power settings > Energy settings.

Set the Shutdown Mode setting
Use the control panel menus to specify the amount of time the printer must be inactive before it shuts 
down.

1. From the home screen on the printer control panel, tap the Menu icon , then the Settings 

icon .

2. Scroll to and open the following menus: General > Energy > Inactivity Shutdown.

3. Tap an option to specify the amount of time the printer must be inactive before it shuts down.

4. When you are finished, tap the Back arrow button to return to the General settings menu, or tap the 
Home button to return to the home screen.

NOTE: You can perform the same operation from the Embedded Web Server by going to General > 
Power settings > Energy settings.

Set scheduled on/off time
Use the control panel menus to specify when to automatically turn the printer on and off.

1. From the home screen on the printer control panel, tap the Menu icon , then Settings .

2. Scroll to and open the following menus: General > Energy > Scheduled Printer On/Off.
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3. Tap an option to specify set the scheduled on or off time (on shown).

4. Set the day(s) and time.

NOTE: You can perform the same operation from the Embedded Web Server by going to General > 
Power settings > Power schedule.

Change the control-panel display brightness
The level of brightness displayed can be adjusted.

To change the brightness of the control panel, tap the Menu icon , then Settings , then General > 
Display > Display Brightness and slide to your desired level.

Configure network settings
You can view and configure the network settings from the Embedded Web Server or the control panel.
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● From the Embedded Web Server: Select the Network tab.

● From the control panel, tap the Menu icon , then Info , then Connectivity.

● From the control panel, tap Settings , then Network.

The following options are available:

● Enable/Disable wireless turns the wireless connection on or off.

● Wireless setup wizard provides an easy way to connect to a wireless network.

● Wi-Fi protected setup allows you to set up a connection with a wireless network using WPS 
(pushbutton or pin) encryption.

● View wireless details displays information about the wireless network.

● IP settings allows you to select the IP address -automatic or manual (Static).

● Print Wireless test report print information about the wireless network.

● Print wireless network test runs diagnostic tests of wireless connectivity.

● Ethernet settings view and print Ethernet details:

– Link speed sets the speed at which data are transmitted over the network. The default is 
Automatic.

– IP settings allows you to view or change the IP address, subnet mask, default gateway, and DNS 
address.

– Network settings.

○ Hostname allows you to change the hostname.

○ Proxy settings allows you to change the proxy settings.

○ Bonjour name allows you to change the bonjour name.

● Restore network defaults.

Configure firewall settings
Firewall features provide network-layer security on both IPv4 and IPv6 networks. The firewall provides 
simple control of IP addresses that are allowed access.

NOTE: In addition to firewall protection at the network layer, the printer also supports open secure 
sockets layer (SSL) standards at the transport layer for secure client-server applications, such as 
client-server authentication or HTTPS Web browsing.

For firewall operation on the printer, go to Menu  > Settings  > Network > Security > Disable 
Firewall: You must configure a firewall policy to apply to specified IP traffic. Firewall policy pages are 
accessed through the Embedded Web Server and displayed by your Web browser. After a policy is 
configured, it is not activated until you click Apply in the Embedded Web Server.
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Creating and using firewall rules
Control IP traffic and allow or drop IP traffic based on IP addresses and services.

Enter up to ten rules, each rule specifying the host addresses, services, and the action to take for those 
addresses and services.

Create a firewall rule
Set up a new rule from the Embedded Web Server.

1. Open the Embedded Web Server.

2. Tap the Network tab, then Network Security > Firewall.

3. Select Enable Firewall.

4. Tap the Add icon, and then follow the onscreen instructions.

NOTE: After you tap Apply, the connection to the Embedded Web Server might be temporarily 
disrupted for a short period of time. If the IP address was unchanged, the Embedded Web Server 
connection will be enabled again. However, if the IP address was changed, use the new IP address to 
open the Embedded Web Server.

Change the priority of firewall rules
You can move a rule up or down to select the priority from the Rule Precedence list.

1. Open the Embedded Web Server.

2. Tap the Network tab, then Network Security > Firewall.

3. Select the priority by selecting a rule and moving up and down using the arrows.

4. Tap Apply.

Change firewall options
Options can always be edited at a later date.

1. Open the Embedded Web Server.

2. Tap the Network tab, then Network Security > Firewall.

3. Change whatever options you wish, then tap Apply.

NOTE: After you tap Apply, the connection to the Embedded Web Server might be temporarily 
disrupted for a short period of time. If the IP address was unchanged, the Embedded Web Server 
connection will be enabled again. However, if the IP address was changed, use the new IP address to 
open the Embedded Web Server.

Reset firewall settings
Restore the printer’s network settings to reset to factory defaults.

Reset network settings
The network settings can be reset or restored to default.
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Go to the control panel and tap the Menu icon , then Settings , then Network, then Restore 
network settings.

Alternatively, tap the Menu icon , then Tools > Maintenance > Restore settings > Restore network 
settings.

NOTE: Print the network configuration page and check that the network settings have been reset.

NOTE: Resetting the printer’s network settings also resets the printer’s firewall settings.
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Paper handling4

To print you can load rolls, single sheets, or use the tray.

General paper-loading advice
You can load paper into the printer in three different ways: from a roll, as a single sheet, or as a stack of 
single sheets from the tray. Switching from one to another is automatic.

CAUTION: If your model has a stand, make sure the printer wheels are locked (the brake lever is 
pressed down) to prevent the printer from moving the automatic switch between the roll and tray.

CAUTION: All paper must be 368.3 mm (14.5 in) or wider. A4 and letter paper should not be loaded in 
landscape orientation.

TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

CAUTION: Keep the bin closed throughout the loading process.

Load a roll onto the spindle
Rolls of different widths can be loaded onto the printer.

1. From the control panel, tap the Paper icon , then select the roll, then tap the Load button.

NOTE: This step is optional: when you start to feed roll paper into the printer, it automatically 
recognizes that you are loading a roll.

2. Remove the spindle from the printer.

WARNING! Do not insert your fingers into the spindle supports during the removal process.
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3. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to 
mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper 
stop from the end of the spindle.

4. If the roll is long, rest the spindle horizontally on a table and load the roll on the table.

5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, 
remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the 
spindle showing the correct orientation.

6. Looking from the front of the printer, put the blue paper stop on to the open end (left side) of the 
spindle, and push into the end of the roll.

7. Ensure the blue paper stop is pushed in as far as it goes.

NOTE: Check that there is no space between the roll and the stops at both ends.
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TIP: If you are a regular user of different paper types, you can change rolls more quickly if you preload 
rolls of different paper types on different spindles. Extra spindles are available for purchase, see 
Accessories on page 99.

Load a roll into the printer
Before you start this procedure, you must have a roll loaded on the spindle.

See Load a roll onto the spindle on page 22.

1. Insert the spindle into the printer, holding it by both ends. The blue hub should be on the left, as 
viewed from the control of the printer.

2. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull 
the paper slightly and cut a straight edge.

3. Insert the edge of the paper into the printer.

WARNING! Do not push your fingers inside the printer's paper path.

4. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the 
printer detects the paper, it beeps, and feeds in the paper automatically.

5. The control panel prompts you to select the paper category and type. To select the paper type, click 
on the type and the different paper categories are shown 
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Plain paper was the last to be loaded.

If you do not see your paper type in the control panel, tap More paper types. If you still cannot find 
your paper type in the whole list, see Paper type is not in the driver or control panel on page 104.

6. The printer checks the alignment and measures the width. If the roll is not correctly aligned, follow 
the instructions on the control-panel display.

NOTE: If you have an unexpected issue at any stage of the paper loading process, see Paper cannot 
be loaded successfully on page 102.

Unload a roll
If there is paper on the roll, you can unload it from the control panel.

1. From the control panel, tap the Paper icon , then select the roll, then tap the Unload button, then 
Unload roll. Afterwards, the tray will become the default active paper source.

2. If the end of the paper is no longer attached to the core, the control panel asks you to unload the roll 
manually.

NOTE: If you don't load a new roll, or if a roll is unloaded; the tray is the default active paper source.

Use the tray (HP DesignJet T850)
Load multiple sheets and ease single sheet printing.

1. If no roll is loaded or the roll has run out of paper, the tray is active by default.

Alternatively, from the control panel, tap the Paper icon , then select the Tray.

2. Adjust the input tray extensions depending on the length of the paper: the first extension for A4 and 
the second extension for A3 paper.
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3. Load sheets of paper into the tray with the printed side facing outwards. Ensure that the sheets are 
all of the same size.

4. Adjust the tray to fit the width of the paper.

Use the tray (HP DesignJet T950)
Load multiple sheets and ease single sheet printing.

1. Open the tray.

2. Load paper into the tray.

3. Adjust the paper guides.
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4. Close the tray.

NOTE: Remember to use width adjusters when loading different media width.

When paper is loaded into the multi-sheet tray, or when the drawer is closed, the control panel confirms 
the paper type and size loaded.

Load a single sheet
Roll paper and single sheets use the same input slot in the printer.

NOTE: If you have a tray see Use the tray (HP DesignJet T850) on page 25.

NOTE: Sheets of width 329 mm (12.95 in) or less should be loaded from the tray.

1. From the control panel, tap the Paper icon , then select Sheet, then tap the Load button.

2. If a roll is already loaded, you have to wait while it is automatically unloaded.

3. Open the roll cover.

4. Select your paper category and type. If you do not see your paper type in the control panel, tap 
More paper types. If you still cannot find your paper type in the whole list, see Paper type is not in 
the driver or control panel on page 104.
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5. When prompted by the control panel, insert the sheet into the right-hand side of the input slot.

WARNING! Do not push your fingers inside the printer's paper path.

6. Align the sheet with the line.

7. Guide the sheet into the printer; this is especially important with thicker papers.

8. The printer checks the alignment and measures the sheet.

NOTE: Depending on the width of the sheet, it feeds out the front of the printer.

9. If the sheet is not correctly aligned, you may be asked to reload it.

NOTE: If you have an unexpected problem at any stage of the paper loading process, see Paper 
cannot be loaded successfully on page 102.

Unload a single sheet
Sheets are unloaded from the front of the printer.

1. To unload a sheet, go to the control panel and tap the Paper icon , then Sheet loaded > Unload.

2. Either catch the sheet manually or allow it to fall into the bin.

NOTE: If you don't load a new sheet, the tray is the default active paper source.
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Use the stacker (T950)
The stacker has two primary configurations: A2/ANSI C and A1/ANSI D (default), or A0/ANSI E. You can 
use either configuration to collect printed line drawings, but must ensure that it matches the substrate 
size.

Up to 40 line drawings can be collected on the stacker. In the A0 configuration, it can hold printed 
documents up to 1189 mm (46.8 in) long.

● For A2 and A1 portrait size collection (default): Install the stacker and sheet organizer as shown for 
the default configuration. Refer to the assembly instructions for detailed set-up information. Ensure 
that the backboard is resting flat on the four support adapters.

Default configuration

● For A0/E size portrait size collection: From the default configuration, standing in front of the 
printer, pull the backboard forward using the two square finger grooves. The backboard will rotate 
downwards and reveal a deeper media fabric path for A0 roll size collection.
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If you want to return to default A2/ANSI C and A1/ANSI D, follow the instructions below:

If the output is not stacked properly, you can try changing from default to regular bin style configuration. 
In this position, the stacker acts as a normal basket. The basket can accept up to 10 A1 or D-sized sheets 
of bond paper. Larger prints should be removed from the basket immediately after printing. See Change 
stacker from default to regular bin style configuration on page 112 on how to configure this position.

To get the best results from your stacker:

● Keep the area around the stacker as clean as possible. Avoid having elements that may interfere 
with the printer's output paper.
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● Ensure the stacker is properly maintained, with all components in one of the primary configurations. 
For any issues, refer to the beginning of this section on the previous page. For example, the stacker's 
outer board must be extended for it to work properly.

● Use according stacker configuration positions for the page size being printed. A0 is for large sizes, 
A1/A2 for A1, ANSI D, Arch D.

● Where possible, group pages of the same size. This facilitates the proper operation of the stacker.

● Where possible, print big pages before smaller ones to maximize stacking capacity.

● A temperature and humidity-controlled environment will help stacker performance. Placing your 
printer in a standard office ambient will get the best results from your stacker.

● The stacker is not intended for plot storage. It is best to pick up plots when they are printed.

● Avoid using very curly rolls. Highly curled plots are difficult to stack properly. Remember that the 
stacker has a regular bin style configuration that may help in this case.

For any issues, refer to the troubleshooting chapter. See Troubleshooting paper issues on page 102.

Use the sheet organizer (T950)
The sheet organizer has two configurations for collecting printed cut-sheets: A4 or A3 (default). You can 
use either configuration, but must ensure it matches the substrate size to prevent collection issues.

The number of plain documents that can be collected on the sheet organizer is up to 50 sheets and 
non-plain is up to 10 sheets. In A3 configuration, the sheet organizer can hold printed documents up to a 
length of 432 mm (17 in).

● For A3 and ANSI B size cut-sheet collection: The length adjuster needs to be in the up position which 
is parallel to the tray. The length-adjuster lever is found on the right side of the tray.

●

● For A4 and ANSI A size cut-sheet collection: The length adjuster needs to be in the down position 
which is perpendicular to the tray. Rotate the lever counter clockwise until it snaps into the down 
position.
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For any issues, refer to the troubleshooting chapter. See Troubleshooting paper issues on page 102.

Sheet organizer configuration 297 mm ≤ Plot length ≤ 420 mm 

A3/ANSI B size or longer

Plot length ≤ 297 mm

A4/ANSI A size or smaller

A3/ANSI B 50 (plain paper)

10 (other paper)

A4/ANSI A 50 (plain paper)

10 (other paper)

View information about the paper
Tap the icon of the active paper source.

The following information is displayed on the control panel:

● Paper type you have selected

● Roll or sheet status

● Width of the paper

If no tray, roll, or single-sheet paper is loaded, the message Out of paper is displayed.

Maintain paper
Always protect your paper and sheets to print at the highest quality.

● Store rolls covered by another piece of paper or cloth

● Store cut sheets covered and clean or brush them before loading them in the printer

● Clean input and output platens

● Always keep the top cover of your printer closed

NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 
121.
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Change the drying time
You may wish to change the drying time setting to suit special printing conditions such as multiple prints 
where time is of higher importance or when you need to be sure ink is dry before handling.

Tap the Menu icon , then Settings , then General > Extra Dry Time. You can select:

● Extended, to set a longer than recommended time to ensure ink is completely dry

● Optimal, to set the default and recommended time for your selected paper (this is the default 
setting)

● Off, to disable the drying time and remove your print as soon as it finishes printing

CAUTION: If the ink is not dry when the print is removed it could leave ink in the output tray and marks 
on the print.

NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right 
away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts 
the paper and then performs the printhead maintenance. However, if the dry time is greater than zero, 
the printer does not cut the paper until after the printhead maintenance has completed.

Turn the automatic cutter on and off
You can change the cutter option to suit your requirements for each print job.

To turn the printer's paper cutter on or off, go to the control panel and tap the Menu icon , then 

Settings , then Output destination > Horizontal cutter.

The default setting is On.

NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the 
paper on loading and unloading rolls.

TIP: To cut roll paper while the automatic cutter is disabled, see Advance button and cut button on 
page 33.

Advance button and cut button
You can advance the paper with, or without cutting it.

From the control panel, tap Paper > Roll, then tap the Advance and Cut icon 

The Advance option advances the paper without cutting it. Cut advances the paper and makes a 
straight cut across the front edge. There are at least two possible reasons why you might want to do this:

● To trim the leading edge of the paper if it is damaged or not straight.

● To advance and cut the paper when the automatic cutter has been disabled.

CAUTION: Remove the cut piece from the output platen. If strips or short prints are left on the output 
platen, the printer could jam. Check also that there are no pieces of paper in the cutter guide.
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NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 
121.
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Printing5

Printing has never been easier or more flexible. Print from computers and mobile devices with the use of 
a variety software, customizable options and advanced settings.

Easy printing with HP Click
HP Click is an easy-to-use software tool designed for people who want a simple way of printing on large 
format printers.

It provides several benefits to simplify the print experience, such as nesting, batch printing and real print 
preview. In combination with the cut sheet tray, you can send to print multi-sized documents all at once.

Ideal for a broad range of graphics and technical applications, including posters, roll-up banners, 
info-graphic presentations, maps, and CAD documents. See the HP website at the following link: 
http://www.hp.com/go/clickDesignJet.

Printing from an application using a printer driver
This is the traditional way of printing from an application.

The correct printer driver must be installed on the computer, and the computer must be connected to 
the printer by network.

When the printer driver has been installed and the computer is connected to the printer, you can print 
from a software application by using the application's own Print command and selecting the correct 
printer.

Advanced print settings
Advanced print settings can be used when the defaults do not meet your requirements.

The rest of this chapter explains the various print settings that you can use. These methods offer a 
relatively large number of settings in order to satisfy all requirements.

TIP: In general you are recommended to use the default settings unless you know that they do not 
meet your requirements.

TIP: If you intend to reuse a particular group of settings repeatedly, you can save those settings under 
a name of your own choice and recall them later. A saved group of settings is known as a 'quick set' in 
the Windows printer driver.
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Select print quality
The printer has various print-quality options because best-quality printing requires some loss of speed, 
while fast printing implies some reduction in print quality.

You can select the options: Best, Normal and Fast. If you select Fast, you can also select Economode, 
which consumes less ink, increases printing speed even further, but reduces print quality. Economode 
can only be selected from the advanced options.

There are supplementary custom options that may have an effect on print quality: Maximum detail. See 
High-quality printing on page 39.

You can select print-quality options in the following ways:

● In the Windows drivers dialog: Go to Basic>Print quality.

● In the Mac OS X Print dialog: go to the Paper/Quality panel and look at the Quality Options section. If 
you select Standard quality options, you will see a simple slider with which you can select speed or 
quality. If you select Custom quality options, you will see the more specific options described above.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the control 
panel.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has 
already received (even if they have not started to print yet).

Select paper size
The paper size can be specified and the document can be rescaled if necessary.

NOTE: The paper size specified should be the paper size the document was created at. It is possible 
to rescale the document to a different size for printing. See Rescale a print on page 38.

● In the Windows driver dialog: Go to Basic > Document size and select the paper size from the list.

● In the Mac OS X Print dialog: Select your printer from the Printer list, then select your paper size 
from the Paper Size list.

NOTE: If your application offers no Page Setup dialog, use the Print dialog.

NOTE: If the paper size is set from your computer, it overrides the paper size setting in the control 
panel.

Custom paper sizes

If you want to choose a paper size that is not included in the list of standard paper sizes, there are 
various different ways to specify it.

Use the Windows printer driver

You can create and save custom paper sizes to suit your requirements.

1. Go to Basic> Document size.

2. Open the drop-down list and scroll down to the (+)Create section.

3. Enter the name, units, and size of the new paper custom size.

4. Tap the Ok button.
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Custom paper sizes created with the printer driver have the following characteristics:

● The paper size is permanent and does not disappear if the driver is closed or the computer is 
turned off.

● The paper size is local to the printer queue and not seen from other printer queues in the same 
computer.

● In Domain server networks, the paper size is local to the computer and not seen from other 
computers sharing the printer queue.

● In Workgroup networks, the paper size is shared among all the computers that share the printer 
queue.

● If the printer queue is deleted, the paper size is deleted with it.

Use Windows forms

Unrestricted users can create a new Windows form.

1. From the Start menu or the control panel, tap Printers > File, and select Server Properties.

2. In the Forms tab, check the Create a new form box.

3. Enter the name and dimensions of the new paper size. Leave the margins as 0.00.

4. Tap the Save form button.

5. Go to the printer driver and select the document size.

6. Select your new paper size from the group of Custom sizes.

Paper sizes created with Windows forms have the following characteristics:

● The paper size is permanent and does not disappear if the driver is closed or the computer is 
turned off.

● Restricted users cannot create paper forms. The manage documents role in the Windows Active 
Directory is the minimum required.

● The paper size is local to the computer and is seen in all the printer queues created on the computer 
that support paper that size.

● If a printer queue is shared, this paper size appears in all the client's computers.

● If a printer queue is shared from another computer, this paper size doesn't appear on the driver´s 
document size list. A Windows form in a shared queue must be created in the server.

● If the printer queue is deleted, the paper size does not disappear.

Use Mac OS X printer driver

You can manage paper customs sizes from the driver.

1. Go to the Print dialog.

2. Select Paper Size>Manage Custom Sizes.
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Select margins options
By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the 
paper. However, you can change this behavior in the following way:

● In the Windows driver dialog: Go to Basic > Margin Layout.

● In the Mac OS X Print dialog: Select the Margins/Layout panel.

At least some of the following options appear:

● Standard or Use application settings. Your image will be printed on a page of the size you have 
selected, with the default margin between the edges of the image and the edges of the paper. The 
image should be small enough to fit between the margins.

● Oversize. You should load paper that is larger than the size you selected in the application or driver. 
If you cut off the margins after printing, you will be left with a page of the size you selected, with no 
margins remaining between your image and the edges of the paper. This is useful when you want 
your image to cover the whole area of the paper.

● Clip Contents By Margins. Your image will be printed on a page of the size you have selected, with 
the default margin between the edges of the image and the edges of the paper. In this case, if the 
image is the same size as the page, the printer assumes that the extreme edges of the image are 
either white or unimportant, and do not need to be printed. This may be useful when your image 
already contains a border.

Print on loaded paper
You can print a job on whichever substrate is loaded in the printer.

● In the Windows driver dialog: Select Use printer settings in the Paper Type option of your printer 
driver.

● In the Mac OS X Print dialog: Select the Paper/Quality panel, then in the Paper Type drop-down list, 
select Any.

NOTE: Use printer settings is the default Paper Type selection.

Rescale a print
You can send an image to the printer at a certain size but tell the printer to rescale it to a different size 
(normally larger). This may be useful:

● If your software does not support large formats

● If your file is too large for the printer's memory; in which case you can reduce the paper size in your 
software and then scale it up again using the control panel option
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You can rescale an image in the following ways:

● You can rescale an image from the Windows driver dialog: Go to the Advanced > Scale.

● By selecting a paper size, the image size is adjusted to the paper size you have selected. For 
example, if you have selected ISO A2 and you print an A3-sized image, it is enlarged to fit the A2 
paper. If the ISO A4 size is selected, the printer reduces a larger image to fit the A4 size.

● The percentage of actual size option enlarges the printable area of the original paper size by the 
percentage indicated, and then adds the margins to create the output paper size.

● In the Mac OS X Print dialog: Select the Paper Handling panel, then Scale to fit paper size, and select 
the paper size to which you want to scale the image. If you want to increase the size of the image, 
make sure that the Scale down only box is unchecked.

If you are printing to a single sheet, you must ensure that the image fits onto the sheet, if not the image 
will be clipped.

Print a draft
You can specify this to save time and cost.

● In the Windows driver dialog: Go to Go to Print quality and select Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly 
for documents containing only text and line drawings:

● In the Windows driver dialog: Go to Advanced > Color and quality and check Economode.

● In the Mac OS X Print dialog: Go to the Paper/Quality panel and move the print-quality slider to the 
extreme left (Speed).

High-quality printing
For unrivaled image quality.

● In the Windows driver dialog: Go to Print quality and select Best.

● In the Mac OS X Print dialog: Go to the Paper/Quality panel and move the print-quality slider to the 
extreme right (Quality).

If you have a high-resolution image

You can improve print sharpness when using glossy paper.

If your image has a resolution greater than the rendering resolution (which you can see in the Custom 
Print Quality Options), print sharpness may be improved by selecting the Maximum Detail option.

This option is available only if you are printing on photo paper.

NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not 
increase the amount of ink used.

Use paper economically
You may be able to save some of your roll paper by removing blank areas and/or by image rotation.

● In the Windows driver dialog: Go to Advanced > Output>Remove blank areas and enable the setting.

You can also select one of the Rotation options.

Print a draft 39



● In the Mac OS X Print dialog: Go to Finishing panel > Remove Blank Areas.

Use ink economically
There are some recommendations you can follow to save ink.

● For draft prints use plain paper, set Print quality to Economode.

● Clean the printhead only when needed. Cleaning the printhead can be useful, but it uses a small 
amount of ink.

● Leave the printer permanently turned on so that it can maintain the printhead in good condition 
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not 
done, the printer may need to use much more ink later to maintain the printhead.

● Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses 
some ink, and its frequency is related to the number of passes made by the printhead.

Printing in grayscale or black-and-white
There are a number of ways to convert all the colors in your image to shades of gray.

● In your application program: Many applications provide this option.

● In the Windows driver dialog: Go to Basic > Color mode and tap Grayscale. Only black ink is used 
to print, except if the paper loaded is glossy, in which case colored inks are used to compose the 
gray shades. You can also select Pure black and white for black and white output only, with no gray 
shades. In this case only black ink is used to print. The Pure black and white option is not supported 
when you print on glossy paper.

● In the Mac OS X Print dialog: Go to the Color Options panel and from the Mode drop-down list, select 
Grayscale. Only black ink is used for printing, unless the paper loaded is glossy, in which case the 
other inks are used to compose gray shades. You can also select Pure black and white for black and 
white output only, with no gray shades. In this case, only black ink is used for printing. The Print in 
pure black and white option is not supported when printing on glossy paper.

Print from USB flash drive
Print an image on a USB flash drive directly to the printer using the control panel (only available on the 
MFP version of this printer).

1. Insert the USB flash drive containing the image or images that you want to print into the printer's 
USB port.

2. From the control-panel home screen, tap the Print icon .

3. Tap Print from USB. 

4. Tap USB settings at the bottom right to select the print settings for the job. To adjust the number 
of copies, select the number of copies field. Use the keypad to enter the number of copies to print. 
Select color options, quality, paper source, output scale and margins.

5. Tap Print to print the job.
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Print using Wi-Fi Direct
With Wi-Fi Direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-
capable device—without connecting to an existing wireless network.

Guidelines for using Wi-Fi Direct
There are essential prerequisites to using Wi-Fi Direct.

● Make sure your computer or mobile device has the necessary software.

● If you are using a computer, make sure you have installed the HP printer software.

● If you have not installed the HP printer software on the computer, connect to Wi-Fi Direct first 
and then install the printer software. Select Wireless when prompted by the printer software for 
a connection type.

● If you are using a mobile device, make sure you have installed a compatible printing app. For more 
information, visit the HP Mobile Printing website at http://www.hp.com/go/mobileprinting. If a local 
version of this website is not available in your country/region or language, you might be directed to 
the HP Mobile Printing website in another country/region or language.

● Make sure Wi-Fi Direct for your printer is turned on.

● Up to five computers and mobile devices can use the same Wi-Fi Direct connection.

● Wi-Fi Direct can be used while the printer is also connected to a network using a wireless 
connection.

● Wi-Fi Direct cannot be used to connect a computer, mobile device, or printer to the Internet.

Turn on Wi-Fi Direct
You can turn on Wi-Fi Direct directly from the control panel, or alternatively from the EWS.

1. From the printer control panel, tap Menu > Settings > Network > Wi-Fi Direct.

2. If the display shows that Wi-Fi Direct is Off, tap Wi-Fi Direct and then switch it on.

3. You can also turn on Wi-Fi Direct from the Embedded Web Server. For more information about using 
the Embedded Web Server, see Access the Embedded Web Server on page 15.

Change connection method
You can change the Wi-Fi Direct connection method, and choose between automatic and manual.

1. From the printer control panel, tap Menu > Settings > Network > Wi-Fi Direct.

2. Tap Connection Method and then select Automatic or Manual:

a. If Automatic was selected during Wi-Fi Direct setup on the printer, the mobile device 
automatically connects to the printer.

b. If Manual was selected during the Wi-Fi Direct setup on the printer, acknowledge the 
connection on the printer display or enter the printer PIN on your mobile device. The PIN 
is provided by the printer when a connection attempt is made.
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Print from a wireless-capable mobile device that supports Wi-Fi Direct
Make sure you have installed the latest version of HP Print Service Plugin on your mobile device.

NOTE: If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on Wi-Fi Direct on your mobile device. For more information, see the documentation provided 
with the mobile device.

3. From your mobile device, select a document from a print enabled application, and then select the 
option to print the document.

The list of available printers appears.

4. From the list of available printers, choose the Wi-Fi Direct name shown such as DIRECT-**-HP 
DesignJet T850 Printer series (where ** are the unique characters to identify your printer), and then 
follow the onscreen instructions on the printer and your mobile device.

5. Print your document.

Print from a wireless-capable mobile device that does not support Wi-Fi Direct
Make sure you have installed a compatible printing app on your mobile device.

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation 
provided with the mobile device.

NOTE: If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the mobile device, connect to a new network. Use the process you normally use to connect to 
a new wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks 
shown such as DIRECT-**-HP DesignJet T850 Printer series (where ** are the unique characters to 
identify your printer).

4. Enter the Wi-Fi Direct password when prompted.

5. Print your document.

Mobile printing

Introduction
You can print to your printer from many mobile devices and from almost any location.

The main method of Mobile Printing is: Direct printing by connection to the same network.

Your printer can be connected to the HP Cloud, providing various benefits. See Choose which 
connection method to use on page 11 for more information.
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See the HP website at the following link: http://www.hp.com/go/designjetmobility for more detailed 
information.

IMPORTANT: The printer must be connected to a network with Internet access: connect an Ethernet 
cable.

IMPORTANT: In order to print/scan from mobile devices, Bonjour, IPP/IPPS and Remote scan protocols 
must be enabled in the Embedded Web Server (Network > Advanced Settings).

Print from Android
You can add and manage your device´s print services from your Android Settings: Settings > Connected 
Devices > Connection Preferences > Printing (exact location may vary depending on Android OS 
version).

NOTE: Printing is only available from applications that offer printing or sharing.

Print and scan using the HP app
Stay productive and organized with the HP app. Print, scan and share your HP printer. Install the HP app 
on all your devices and save time for what matters.

You must have Android 9.0 or later.

If it is not already installed on your device, download and install the HP app from the Google Play store at 
the following link: https://play.google.com/store/apps/details?id=com.hp.printercontrol.

To have access to all the HP app's features, connect your printer to HP Cloud and log in using your HP 
Credentials.

Make sure your device and printer are operating on the same network and follow the steps below:

To print using the HP app:

1. Open the HP app and select your printer.

2. Select whether you want to print documents or photos from your local device, or link your Google 
Drive, Dropbox, or other accounts to access your content.

3. Use the edit options to adjust quality, color, and other settings if you wish to make such adjustments.

4. Tap Print and collect your printed documents.

To scan using the HP app:

1. Place the document that you want to scan on the scanner area.

2. Open the HP app and start scanning from it.

3. Once the scanned document is received in the HP app, you can either store the document in your 
mobile device, send it by email, or upload it directly to your preferred cloud repository.

NOTE: Scanning is only available in MFP models.

Print using the HP Print Service plugin
You must have Android 6.0 or later.
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If it is not already installed on your device, download, install, and enable the HP Print Service plugin from 
the Google Play store at https://play.google.com/store/apps/details?id=com.hp.android.printservice.

To use the plugin, follow the steps below:

1. Open the document or photo you want to print, tap the Menu icon, then tap Print.

2. Choose your printer from the list. Printers discovered by the HP Print Service plugin will appear with 
the HP logo.

3. Check the print settings, then tap Print.

Alternatively, for document types PDF, JPEG, and PNG, you can use the Android Share button and select 
the HP Print Service plugin from the list of options.

Print using the Mopria Print Service
You must have Android 5.0 or later.

If it is not already installed on your device, download, install, and enable the Mopria Print Service from 
the Google Play store at https://play.google.com/store/apps/details?id=org.mopria.printplugin.

To use Mopria, follow the steps below:

1. Open the document or photo you want to print, tap the Menu icon, then tap Print.

2. Choose your printer from the list. Printers discovered by the Mopria Print Service will appear with 
the Mopria Alliance logo.

3. Check the print settings, then tap Print.

Alternatively, for document types PDF, JPEG, and PNG, you can use the Android Share button and select 
Mopria from the list of options.

For more information, visit the Mopria website at https://mopria.org/.

Print using the Android default print service
You must have Android 12.0 or later.

The Android default print service comes pre-installed on Android devices, but is enabled only if no other 
compatible print service is installed, such as the HP Print Service plugin or the Mopria Print Service.

To use the default service, follow the steps below:

1. Open the document or photo you want to print, tap the Menu icon, then tap Print.

2. Choose your printer from the list. Printers discovered by the default print service will appear with a 
generic printer logo.

3. Check the print settings, then tap Print.

Print from Apple iOS
NOTE: Printing is only available from applications that offer printing or sharing.

Print and scan using the HP app
Stay productive and organized with the HP app. Print, scan and share your HP printer. Install the HP on all 
your devices and save time for what matters.
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You must have iOS/iPadOS 15.0 or later.

You can download the HP app from the iTunes website at following link: https://itunes.apple.com/app/
id469284907

To have access to all the HP app's features, connect your printer to HP Cloud and log in using your HP 
credentials.

Make sure your device and printer are operating on the same network and follow the steps below:

To print using the HP app:

1. Open the HP app and select your printer.

2. Select whether you want to print documents or photos from your local device, or link your Google 
Drive, Dropbox, or other accounts to access your content.

3. Use the edit options to adjust quality, color, and other settings if you wish to make such adjustments.

4. Tap Print and collect your printed documents.

To scan using the HP app:

1. Place the document that you want to scan on the scanner area.

2. Open the HP app and start scanning from it.

3. Once the scanned document is received in the HP app, you can either store the document in your 
mobile device, send it by email, or upload it directly to your preferred cloud repository.

Print using AirPrint
iOS printing is enabled through AirPrint. You must have iOS 7.0 or later.

1. Open the document or photo you want to print and press the Share button.

2. Swipe the screen to reveal the Print button and press it.

3. Check the print settings, then press Print.

Print from Chrome OS
Printing is only available from applications that offer printing or sharing.

Print using Chrome OS Native Print

With the latest ChromeOS versions, you can use native printing capabilities for basic printing without 
having to install additional software.

1. Choose your content. Open the document or photo you want to print, tap the menu icon and select 
Print.

2. Choose your printer. Select from the list of printers that appears. Printers discovered by ChromeOS 
Native Print will appear with a generic printer logo.

3. Confirm that the correct printer and print settings are selected. Tap Print and collect your printed 
documents.
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For more information, visit the Google website at the following link: 
https://support.google.com/chrome/a/topic/9045842.

Mobile specifications
The HP app requires you to have an Internet connection.

Print and scan functionalities require that the mobile device and printer be on the same network.

NOTE: OS versions supported may vary in the future.

Reprint (Only HP DesignJet T950)
You can reprint from the control panel.

1. Tap the Jobs icon on the home screen to view the job queue on the control panel. The job queue 
includes jobs that have already been printed.

2. Scroll down to the History section to see the printed jobs.

3. Select a printed job. 

Only the number of copies can be modified when reprinting a job. The reprint feature can be enabled or 
disabled from the Embedded Web Server by selecting Jobs and then Jobs settings. This requires being 
logged in as an admin user.
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Scanning (only MFP)6

MFP models have an integrated color scanner capable of scanning images of the same width that the 
printer can print. Scan resolution is up to 600 dpi in RGB color with 24 bits per pixel, or grayscale with 8 
bits per pixel, or black and white with 1 bit per pixel.

Quick Sets
A Quick Set is a named group of settings with defined default values that help you to be more efficient.

Quick Sets are convenient for inexperienced users, and can be used to scan, copy, and print jobs.

Factory Quick Sets
The printer comes with some factory Quick Sets already defined, designed to support typical user 
requirements.

User Quick Sets
Quick Sets can be defined by a user and created or modified with the Embedded Web Server.

For information about the Embedded Web Server, see Access the Embedded Web Server on page 15

To create or modify a user Quick Set, tap Quick Sets in the menu at the left side of the Embedded Web 
Server window.

Your own Quick Sets can be duplicated, edited temporarily or permanently, and deleted. Factory Quick 
Sets can only be duplicated.
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To add a new Quick Set:

1. Tap the Add icon . A window opens to create a new Quick Set to scan, copy, or print jobs.

2. Select from the drop-down list where the new Quick Set will appear. Choose from: Copy, Network 
folder, USB drive, or Print from network folder, then tap Next.

3. Give the new Quick Set a Name, a Description, and choose the Start Option from the drop-down list. 
When ready, tap Next.
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4. Select Use the following credentials, then tap Next.

5. Select the Input options you require, then tap Next.

6. A summary of the Quick Set appears. Tap Next to save the Quick Set and continue.
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7. The Quick Set is added and now available to use. Tap OK to finish.

Paper types suitable for scanning
Paper categories supported for your HP scanner.

HP recommends:

● White paper: Any matte original printed with inkjet technology. For instance, anything printed 
with this printer on any of these paper types: HP Universal Inkjet Bond Paper, HP Coated Paper, 
HP Heavyweight Coated Paper, plain paper.

● Translucent paper: Semi-transparent tracing papers (> 65 g/m²), including HP Natural Tracing Paper, 
HP Vellum, and HP Translucent Bond.

● Blueprints: For scanning blueprint originals with optimum results, in grayscale only. This option 
greatly enhances the contrast of the resulting image.

The following paper types are not supported by the scanner:

● Film

● Backlit material

● Cling material

● Translucent paper (< 65 g/m²)

WARNING! Do not use documents with staples or rough surfaces/materials that can damage the 
scanner glass.

Scan widget
The scan widget allows you to quickly start scanning with predefined settings and send your scan to a 
network folder.

It can be found on control panel's home screen by sliding the copy widget to the left.

To start the scanning process, click the send button. See Scan to network setup process on page 55
for more information on the complete process.
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Tap the Settings icon  to edit defined settings. See Scan settings on page 53 for more information.

NOTE: The scan widget settings used to scan and the folder where the job is sent to can be changed 
in the Embedded Web Server: Scan > Scan to network folder.

IMPORTANT: Before using the scan widget, a network folder needs to be configured. See Scan to 
network setup process on page 55.

Scan destinations
The scanner is capable of scanning directly to different destinations.

You can scan to the following:

● To network folder

● To email address

● To USB flash drive

You can start a scanning process in two ways:

● At the control panel: select Scan.

Then select where you would like to store the scanned image.

● Feed the document directly: Load the sheet with the printed side facing upwards (you can also load 
the sheet before step 1, if you prefer).

Align the center of the sheet approximately with the center of the scanner. Use the standard size 
markings to help you.
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NOTE: The maximum length of paper that the scanner can scan depends on the paper width, 
among other options such as scan resolution. An alert is displayed if the maximum length is 
exceeded.

Push the sheet into the insertion slot until you feel it contact the rollers. The scanner will 
automatically grab the sheet and move it into position for scanning. If you feel that the sheet has 
loaded badly and you want to try again, you can pull it out manually.

IMPORTANT: Do not try to feed the scanner while the printer is printing, as only one action can be 
done at a time. Paper will not be accepted by the scanner during printing.

At the control panel, go to the home screen and select Scan, then select where you would like to 
store the scanned image:

– Into an email: Before using this option, make sure the setup process has been completed. See 
Scan to email setup process on page 54. If the setup process has not been done, the following 
message appears on the control panel:

If you have already configured the email server in the Embedded Web Server, you must provide 
the email address(es) to which the scanned job will be sent.

Scan to email user interface options:

○ Sender

○ Send to:

● Contact

● Group

● Addresses

Tap Start Scan to start the scanning process.

NOTE: Before starting the process, make sure you have followed the Scan to email setup 
process. The scan to email setup has to be done from the Embedded Web Server. For more 
information, go to Scan to email setup process on Scan to email setup process on page 54.

NOTE: If the scanned image is larger than the maximum permitted, the printer will ask you if 
you want to try to send it anyway. If you want to change this option, go to the Embedded Web 
Server and select Scan to email setup > Maximum size of email..

– To a network folder: In this case, you must choose a folder accessible through the network.

52 Chapter 6  Scanning (only MFP)



To create and/or change the folder options, go to the Embedded Web Server, then Scan > Scan 
to network folder > Default folder, or you can create a network folder quick set.

A security PIN can be associated with each folder; check Network folder setup on Scan to 
network setup process on page 55.

Scan to network folder user interface options:

○ Save As

○ File name

○ Resolution

Tap the Settings icon  to change scan to network folder settings. For further information on 
settings go to Scan to network setup process on page 55.

Tap Start Scan to start the scanning process.

NOTE: Before starting the process, make sure you have followed the Scan to Network folder 
setup process. The scan to Network folder setup has to be done from the Embedded Web 
Server. For more information, go to Scan to Network folder setup process on Scan to network 
setup process on page 55.

– To USB: When scanning to USB, a folder named HPSCANS is created on the USB drive. The 
file is saved in the folder. The file is saved in PDF, JPEG, or TIFF format using an automatically 
generated file name if you have not given it one.

Scan to USB user interface options:

○ Save As (format file

○ File name

○ Resolution

Go to Menu > Scan to change scan to USB settings. For further information on settings go to 
Scan settings on page 53.

Tap Start Scan to start the scanning process.

– Scanning from a mobile device: You can also scan from your smartphone or tablet: See Mobile 
printing on page 42 for more information.

Scan settings
Some of the default scan settings are displayed. Tap Settings  to see the complete list of settings, and 
check in particular that the original type setting corresponds to the paper type that you intend to scan.

● Original paper type:

– a) White

– b) Blueprint: for scanning blueprint originals with optimum results. This option converts to 
grayscale and inverts the colors, if needed, producing a white background with black lines.
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– c) Translucent paper: is a mode specifically for scanning NTP, vellum, and other translucent 
papers.

● Color options: allows you to choose color, grayscale, or black and white scanning.

● Resolutions: allows you to specify the scan resolution (200, 300, 600 dpi)

● Long original: allows you to scan up to 8 meters (26.25 feet) long originals.

● Lighter/Darker: allows you to modify the lightness of the scan using a slider.

● Background color removal: cleans the color in the original background.

● Background noise removal: clears the noise on the original background.

● Scan edge-to-edge output: do not crop the scan to the original edges. It is Off by default.

● Automatic deskew: corrects the skew automatically. It is On by default.

● File type: Format allows you to specify the format of the file in which the scanned image will be 
saved: TIFF, JPEG, or PDF.

● File name

● File size: allows you to specify the level of compression: High (the default level), Medium, or Low. This 
option is available if the format is JPEG or PDF.

To configure default scan settings, go to the EWS, then Scan, Scan to email , Scan to network folder, or 
Scan to USB.

NOTE: The 'Scan to network' widget uses the settings defined in the EWS under Scan to network 
folder.

Scan options setup process
A scanned image may be saved to a USB flash drive, a network folder, or an email message. The USB 
flash drive options require no preparation, but the other options will not work until they have been set up.

To set up the different scan options, go to the Embedded Web Server in your computer. Access the 
Embedded Web Server by typing the printer's IP address into your browser. Find your printer's IP address 
on your printer's Home screen, on the dashboard. Once in the Embedded Web Server, look for the option 
you would like to set up.

Scan to email setup process
To set up Scan to email, follow the process in the Embedded Web Server. Go to General > Email Servers.
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Outgoing email settings

● To: select the default address destination

● From: define the default email address for the sender

● Default from: specify the default email name

● Default display name: specify the default name for the email sender

● SMTP Server: the IP address of the outgoing mail server (SMTP) that will process all email messages 
from the printer. If the mail server requires authentication, email notifications will not work.

● SMTP Port: set the default SMTP port number of your outgoing email server

● Maximum size of email: defined by your email server

● Server Authentication: depends on your email server settings

Scan to network setup process
A scanned image may be saved in a network folder. The USB flash drive option requires no preparation, 
but the other options will not work until they have been set up. To set up the Scan to network folder, first 
you have to create a folder on your computer.

1. Create a folder on a computer that the scanner can access through the network. See Example: 
Create a scan-to-network folder under Windows on page 57 or Example: Create a scan-to-network 
folder under Mac OS X on page 59.

2. Create a user account on the same computer for the printer.

3. Change the sharing options of the folder so that it is shared with the 'scanner user', and assign full 
control of the folder to that user.
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4. Create a share name for the folder.

Once the shared folder is created, go to the Embedded Web Server and follow the instructions 
under the Scan to network folder setup process.

5. In the printer's Embedded Web Server, select the Jobs tab and then Network folder.

6. Select an existing profile or to create a new network folder profile.

7. Write a name for the folder and type the network path.

● Display Name is displayed in the control panel when you are choosing the scan destination. It 
may be different from the network or FTP folder name.

● Network Path should contain the network name of the remote computer.

The server and folder names are used to connect to the shared folder by building a network 
folder path as follows: \\server name\folder name

For a Network Path, enter the name or IP address of the remote computer and the name of the 
shared folder.

Select Next to continue.

8. Define Log-in Authentication settings.

● User name should contain the name of the 'scanner user'.
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● Password should contain the password of the 'scanner user'.

Type the user name and password of the 'scanner user' that you have already created on the 
remote computer. Leave the user domain field empty unless the user is a member of a Windows 
domain. If the user is only a local user of the remote computer, leave the field empty. You can 
use the name (instead of the IP address) in the server name field only if the shared folder is on a 
Windows computer in the same local network. This must be a simple name (up to 16 characters 
long) without a domain suffix (without any dots in the name). Fully qualified DNS domain names 
are not supported. If the product and the network folder are in different networks, or if the remote 
computer is not running Windows, then you must use the IPv4 address instead of the name of the 
remote computer. On IPv6 networks the IPv6 address is also supported.

Select Next to continue.

9. Define the Setup Configuration for files scanned to the network folder.

NOTE: The scan settings defined for a folder, are exclusive for the setup folder.

10. Click Add to save the configuration.

NOTE: If the product has already been configured for scanning to the network and you now want 
to use a different shared folder, click Edit.

From server/from printer
To be able to scan from server/from printer, you have to follow the Windows setup process defined for 
adding a device.

Look for Devices and printers > Add a device and follow the instructions.

Example: Create a scan-to-network folder under Windows
The printer has a feature that enables it to scan a document and save it to a network folder. You need an 
new account and dedicated folder set up on the remote computer.

1. Create a new user account for the 'scanner user' on the remote computer. You can use an existing 
user account for this purpose, but it is not recommended.

2. Create a new folder on the remote computer, unless you want to use an existing folder.

3. Right-click the folder and select Properties.
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4. In the Sharing tab, click the Advanced Sharing button.

5. Check the Share this folder box.
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6. You need to ensure that the 'scanner user' has full read/write control over the shared folder. To do 
this, click Permissions and grant Full Control to the user (or to any suitable group that includes that 
user).

7. If there is a Security tab in the Properties window for your folder, then you must also grant the same 
user Full Control over the folder in the Security tab. Only some file systems such as NTFS require 
this.

The 'scanner user' can now access the folder and write files to it. Next, you must configure the 
printer to send scans to the folder.

Example: Create a scan-to-network folder under Mac OS X
The printer has a feature that enables it to scan a document and save it to a network folder. You need an 
new account and dedicated folder set up on the remote computer.

1. Create a new user account for the 'scanner user' on the remote computer. You can use an existing 
user account for this purpose, but it is not recommended.
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2. Create or choose a folder on the remote computer. By default, Mac OS X users have a Public folder 
that can easily be used for this purpose.

3. Open the System Preferences application and select the Sharing icon.

4. Make sure the 'scanner user' has Read & Write access to the folder.

5. Click Options.

6. Check the Share files and folder using SMB box, and make sure that the 'scanner user' is checked 
in the On column.
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7. Click Done. You will now see file sharing enabled and Windows sharing on.

The 'scanner user' can now access the folder and write files to it. Next, you must configure the 
printer to send scans to the folder.

Scan from the HP app
You can also scan directly to your mobile device by using the HP app (available for Android and iOS).

For more information, see Mobile printing on page 42.

Web scan
User can also scan from the Embedded Web Server.

From the Embedded Web Server, go to Web Scan and follow the instructions.

Scanning to the network folder using the widget
The scan-to-network-folder widget is a fast way to start a scan and send the document to a network 
folder.

With a document loaded in the scanner, tap the Send button  to start scanning it.

NOTE: If you need to change a setting before the scan starts, tap the Options icon.
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The widget settings used to scan and the folder to which the job is sent can be changed in the 
Embedded Web Server. See Access the Embedded Web Server on page 15. However, you will then need 
to restart the printer to see the settings updated in the widget.
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Copying (only MFP)7

Copy settings offer you a range of options to adjust, enhance, and alter (color), to ensure that the image 
is scanned and printed for optimum results. You can scan to fill the whole sheet by remove any cropping, 
correct skew, and even resize the copy to print at a desired size.

Copy
The function is easy to use and controlled from the control panel.

1. On the control panel, tap the Copy menu.

2. You can select a factory Quick Set or one you have created, or if needed, select each specific 
setting.

3. Select the suitable option for your document. The options are the following:

● Lines

● Image

● Mixed (a document that has both images and lines, such as a map)

4. Select the number of copies that you want to make. You can choose a number ranging from 1 to 99. 
You can enter the number manually or select it from a slider.

5. Select the paper source you are going to copy to:

● Roll

● Tray

● Single sheet

6. Select the quality of your copy. There are 3 different quality options: Best, Normal, Draft.
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7. Tap Copy. The printer will prompt you to load the original document if you haven’t already.

NOTE: The maximum length of paper that the scanner can scan depends on the paper length and 
the scan resolution. An alert is displayed if the maximum memory is exceeded.

Push the sheet into the insertion slot until you feel it contact the rollers. The scanner will 
automatically grab the sheet and move it into position for scanning. If you feel that the sheet 
has loaded badly and you want to try again, you can pull it out manually.

IMPORTANT: Do not try to feed the scanner while the printer is printing, as only one action can be 
done at a time.

Copy widget
The copy widget allows you to quickly start copying with predefined settings.

It can be found at the top of the control panel's home screen. See Copy on page 63.

Tap on the (-) icon or (+) icon to edit the number of copies.

Click the Copy button to start the copying process. See Copy on page 63 for more information on the 
complete process.

Tap the Settings icon  to edit defined settings. See Copy settings on page 65 for more information.

NOTE: The copy widget settings used to copy can be changed in the Embedded Web Server: Copy > 
Default copy options.

64 Chapter 7  Copying (only MFP)



Copy settings
Some of the default copy settings are displayed. Tap Settings to see the complete list of settings.

Original settings

● Content type

● Lighter/darker allows you to adjust the lightness of the copy.

● Background noise removal reduces image defects such as wrinkles.

● Background color removal reduces color defects in the original background.

● Original Paper Type: White, Blueprint, and Translucent

Scanning

● Color mode allows you to specify the colors for your copy (color, grayscale, black and white).

● Automatic Deskew automatically corrects skew. It is On by default.

● Edge-to-Edge Output ensures the copy is not cropped to the edge of the original image. It is Off by 
default.

Printing settings

● Output Scale allows you to resize the print. There are four options:

– None: The original size is not scaled ( default)

– Custom: To resize the copy to a specific percentage

– Standard Sizes: Resize to a specific standard size

– Loaded papers: Resize to the size of one of the loaded papers

● Paper Source allows you to choose between Automatic (default), Roll, Tray or Single Sheet when 
printing.
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● Copy Margins allows you to decide how to manage the printer margins. You can print the scanned 
image as is and add the margins or you can clip the image with the printing margins (Add to 
Contents, Clip to Contents).

● Quality defines the copy resolution and print quality.

Defaults

To define default copy settings, go to the EWS > Copy > Default Copy Options.

NOTE: Default copy options are used by the copy widget.

Copy from the widget

The copy widget is a fast way to start a copy.

With a document loaded in the scanner, tap on the Copy button to quickly start copying. The number of 
copies can be defined for the copy widget.
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Quick Sets8

A Quick Set is a named group of settings with defined default values.

Quick Sets help you be more efficient and are convenient for less experienced users. They offer a 'one 
click' action to scan, copy, and print jobs.

Factory Quick Sets
The printer comes with some pre-defined factory Quick Sets, designed to support typical user 
requirements.

See Launching Quick Sets on page 70 for more information.

Managing Quick Sets
Quick Sets can be managed from the Embedded Web Server.

Look for the Quick Sets option on the menu. See Access the Embedded Web Server on page 15 for more 
information.

Depending on the permissions your printer has set, you can create, delete, edit, or view a Quick Set.

Creating a new Quick Set
Quick Sets can be created from the Embedded Web Server.

1. Tap the Add icon (+). A window opens to create a new Quick Set to scan, copy, or print jobs.
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2. Select the new type of Quick Set from the drop-down list. Choose from Copy, Email, Network Folder, 
USB Drive, or Print from USB, then tap Next.

3. Give the new Quick Set a name, description, and choose the start option from the drop-down list, 
then tap Next.

4. Select the input options you require, then tap Next.

5. A summary of the Quick Set appears. Tap Next to save the Quick Set and continue.

6. The Quick Set is added and now available to use. Tap OK to finish.

7. The new Quick Set will now appear in the list.
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Editing a Quick Set
Quick Sets can be edited from the Embedded Web Server.

NOTE: Factory Quick Sets cannot be edited.

1. Select the Quick Set to edit by clicking on the checkbox near the Quick Set name.

2. Tap the Edit icon. A window will open with information on the Quick Set.

3. Edit the information and follow the steps. Tap OK to finish.

Deleting a Quick Set
Quick Sets can be deleted from the Embedded Web Server.

NOTE: Factory Quick Sets cannot be deleted.

1. Select the Quick Set you want to delete by clicking on the checkbox by the Quick Set's name.

2. Tap the Delete icon. A confirmation window will open.

3. The Quick Set will be deleted. Tap OK to finish.

Copying a Quick Set
Quick Sets can be copied from the Embedded Web Server.

1. Select the Quick Set you want to copy by clicking on the checkbox by the Quick Set's name.
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2. Tap the Copy icon. A window will open with information on the Quick Set.

3. Give the Quick Set a new name, add a description, and make any other changes to settings.

4. Follow the steps until you have saved the Quick Set. Tap OK to finish. 

5. The duplicated Quick Set will now appear in the list.

Viewing a Quick Set
Quick Sets can be viewed from the Embedded Web Server.

NOTE: Only factory Quick Sets can be viewed.

1. Select the Quick Set you want to view by clicking on the checkbox by the Quick Set's name.

2. Tap the View icon. A window will open with information on the Quick Set.

3. Check any information you want to check and follow the steps. Tap OK to finish.

Launching Quick Sets
Quick Sets can be launched from the Embedded Web Server.

1. From the control panel, tap on the Scan or Copy menu.
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2. Select an appropriate Quick Set for your copy or scan job. Quick Sets can be temporally modified 
by changing a setting.

NOTE: Created Quick Sets will appear here along with factory Quick Sets.

3. Click on Copy or Send to start the process.

4. Follow the instructions on the control panel to finish.
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Practical printing examples9

Step by step examples to print drafts, projects, presentations etc. to help you follow correct procedure 
with your jobs.

Print a draft for revision with the correct scale
Page size and orientation may not always be set as you require. This can be altered.

Using Adobe Acrobat
Print a revision draft with the correct scale.

1. In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to 
check the page size.

2. Select File > Print and ensure that Page Sizing & Handling is set to Actual size.

NOTE: The page size will not be automatically selected according to the drawing size.

3. Click the Properties button.

4. Choose whatever Document Size and Print Quality you want to use. If you want to define a new 
custom paper size, follow the instructions in Custom paper sizes on page 36.

5. Select Rotation, then Autorotate.
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6. Click OK, and check that the print preview in the Print dialog box seems correct.

Print a PDF multipage job from Adobe Acrobat Reader or Adobe 
Acrobat Pro

Set up for a multipage job is a quick and simple process.

You can print a multipage job from Adobe Acrobat.

1. Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always 
using the latest version).

2. Click File > Print.

3. Select the printer and driver.

4. Check the Choose paper source by PDF page size box.

5. Adjust other properties in the driver properties window, as required.

6. Click the Print button.

Print a document with the correct colors
Print a document from Adobe Acrobat and Adobe Photoshop, with the emphasis on color management.

Using Adobe Acrobat Reader
The print process is very simple. Acrobat Reader is the most basic application for PDF files; several color 
management tools common in more sophisticated applications are not explicitly present, and work by 
default with presets that cannot be changed.

For example, there is no way to select a working color space; a default color space, most likely sRGB, 
is applied. This color space is used for screen display, for example. Also, as an alternative color profile 
when no other is specified by a file, as will be explained later.
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1. Click File > Print.

2. Select the printer and driver from the Printer drop-down menu in the Print dialog box. Driver 
settings can be adjusted by clicking the Properties button.

3. Adjust the color settings in the driver properties window. Click the Properties button in the Print 
dialog and set the Color option in the Color mode section. Click OK.

4. Click the Advanced button in the Print dialog box to set color management options. Check the box 
Let printer determine colors.

5. If the document contains several color profiles and you are not sure what the result will be, you 
can flatten the document first and print it as seen on the screen. To do this, check the box Print 
As Image in the Advanced Print Setup dialog box. In this case, the rasterization is performed by 
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Acrobat Reader before calling the driver; whereas, if you do not check this box, the rasterization is 
performed by the driver. So checking the box may have a visible effect on the look of the printed 
document.

Using Adobe Acrobat Pro
This is a professional application that allows full color management. See briefly described, the options 
to select a working color space, convert images to a desired color space, and print.

1. PDF files may not contain a color profile. In the absence of a color profile, Acrobat uses a working 
color space by default. To choose a working color space, first click Edit > Preferences.

2. In the Preferences dialog box, you can choose RGB, CMYK, and grayscale working color spaces.

3. PDF files can contain elements with different color profiles. Some may have color profiles, some 
may not. The working color space will affect only those without a color profile. If you want to attach 
a specific color profile to the document, you must convert the contents of the document as follows. 
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First, select Convert Colors from View > Tools > Print Production or by clicking the icon in the status 
bar.

4. Select the elements you want to convert by specifying matching criteria (object type and/or color 
type) and then the conversion attributes. If you want to change the embedded color profile, you 
can select Any Object and Any Colorspace in the Matching Criteria section. In the Conversion 
Attributes section you can choose, for example, to embed an Adobe RGB (1998) profile by selecting 
it as the Conversion Profile, checking the Embed box, clicking the OK button, and saving the file to 
keep the changes. The saved file will have an embedded Adobe RGB color profile.

5. To print the document, choose a printer from the Print dialog box, click the Properties button, and in 
the Color mode section, set the color options.

IMPORTANT: Select Print in color and Printer managed colors.

6. In the Print dialog box, click the Print button to print the document.

Using Adobe Photoshop
The printer can manage colors directly.

1. In Photoshop, click File > Print, then select your printer.
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2. In the Color Management section, set the Color Handling option to Printer Manages Colors.

Print a project using Autodesk AutoCAD
Set up a plot to print from a model or a layout.

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the 
model.
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2. Click the Plot icon at the top of the window.

3. The Plot window opens.

4. You can see further options by clicking the circular button in the lower right corner of the window.

NOTE: The Quality option here does not refer to the final print quality but to the quality of 
AutoCAD viewport objects that are sent for printing.

5. Select your printer and click the Properties button.
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6. Select the Device and Document Settings tab, and click the Custom Properties button.

7. In the Driver, select the paper type that you intend to use.

8. Select the print quality.

9. If you intend to print on roll paper, you must decide where the printer should cut the paper.

● With the Windows driver: Select Document > Margin layout > Clip content by margins.

10. Select the Rotation option Autorotate. Autorotation can help to avoid wasting paper.

11. Click the OK button and save your configuration changes to a PC3 file.

12. When you have clicked the OK button in the Plot window, the printer will construct a print preview.

Print a presentation
Setup AutoCAD or Photoshop presentations.

Using Autodesk AutoCAD
Print a presentation with Autodesk AutoCAD.
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1. Open the AutoCAD file and select a layout.

2. Click the Plot icon at the top of the window.

3. Ensure that the correct printer is selected, then click the Properties button.
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4. Select the Device and Document Settings tab, and click the Custom Properties button.

5. In the Driver, select the paper type that you intend to use.

NOTE: If you select neither the paper source nor the paper type, the printer will not print on any 
protected roll.

6. Select the print quality.

7. If you intend to print on roll paper, you must decide where the printer should cut the paper.

● With the Windows driver: Select Document > Margin layout > Clip content by margins.

8. Select the Rotation option Autorotate. Autorotation can help to avoid wasting paper.

9. Click the OK button and save your configuration changes to a PC3 file.

10. When you have clicked the OK button in the Plot window, the printer will construct a print preview.

Using Adobe Photoshop
Print a presentation with Adobe Photoshop.

1. In Photoshop, click File > Print and then select your printer.

2. Click Print settings, then select the Document size option.

3. Choose from the available paper sizes.

If you don't find your desired paper size, create it by following the instructions in Custom paper 
sizes on page 36.

4. Select Show preview before printing. You may also wish to change the default paper source, paper 
type and print quality.

5. In the Color section, the default color management option is Printer managed colors, which is the 
correct option as you have already selected Printer Manages Colors in Photoshop.
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Handling ink cartridges and printhead10

There are four replaceable ink cartridges that supply the printhead. You can check status information, 
and easily change an ink cartridge when required.

About the ink cartridges
Ink cartridges store the ink and are connected to the printhead, which distributes the ink on the paper.

To purchase additional cartridges, see Accessories on page 99.

CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive 
devices. Avoid touching pins, leads and circuitry.

NOTE: This printer is intended to work only with cartridges that have a new or reused HP chip, and it 
uses dynamic security measures to block cartridges using a non-HP chip. Periodic firmware updates 
will maintain the effectiveness of these measures and block cartridges that previously worked. A 
reused HP chip enables the use of reused, remanufactured, and refilled cartridges. More on the HP 
website at the following link: http://www.hp.com/learn/ds.

Store supply usage data
The HP cartridge used with this printer contains a memory chip that assists in the operation of the 
printer.

The HP cartridge used with this printer contains a memory chip that assists in the operation of the 
printer.

The memory chip stores a limited set of anonymous information about the usage of the printer, which 
can include the following: the date when the cartridge was first installed, the date when the cartridge 
was last used, the number of pages printed using the cartridge, the page coverage, the printing modes 
used, any printing errors that may have occurred, and the printer model. This information helps HP to 
design future products to meet our customers' printing needs.

The information collected by the memory chip does not include information that could be used to 
identify a customer or user of the cartridge or printer.

HP collects a sample of the memory chips from ink cartridges returned to HP's free return and recycling 
program (HP Planet Partners, see the HP website at the following link: http://www.hp.com/recycle). The 
sampled memory chips are read and studied in order to improve future HP products.

Any third party possessing the printer cartridge might have access to the information on the memory 
chip. If you prefer if you prefer to not allow access to this information, you can render the chip inoperable. 
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However, after you render the memory chip inoperable, the memory chip cannot be used in an HP 
printer.

If you are concerned about providing this anonymous information, you can turn off the memory chip's 
ability to collect printer usage information. To do so, access the EWS and tap Security > Security 
Settings, then in the Printer Settings section, toggle to Anonymous usage information. This does not 
prevent the cartridge from working normally in other respects. However, if you change your mind later, 
you can restore the factory defaults to resume collecting printer usage information.

Check ink cartridge status
Information about the evolution of the ink cartridges.

To view the ink levels of your ink cartridges, tap the Supplies icon , then Ink Cartridges on the control 
panel. For more information, tap the specific cartridge.

In the Embedded Web Server go to Home > Estimated Cartridges Levels or Supplies > Cartridges.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 
151.

Replace an ink cartridge
There are two occasions when you need to replace an ink cartridge.

● The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing 
(you can use up the remaining ink in the first cartridge at a more convenient time).

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION: Do not try to remove an ink cartridge while printing.

CAUTION: Remove an ink cartridge only if you are ready to insert another one.

1. Make sure the printer is turned on.

2. Open the ink cartridge cover on the rear right-hand side of the printer.

3. Remove the ink cartridge.
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4. Insert the new ink cartridge. Make sure that you insert the ink cartridge into the slot that has the 
same colored letter as the cartridge you are installing.

5. Close the ink cartridge cover.

About the printhead
The printhead, which is supplied installed in the printer, is connected to the ink cartridges and jets ink 
onto the paper.

CAUTION: Observe precautions when handling the printhead, because it is an ESD-sensitive device. 
Avoid touching pins, leads, and circuitry.

For information on replacing printheads, see Replace the printhead on page 87.

Safe mode
Under certain conditions, including printer operation outside of environmental specifications, and when 
a used, refilled, or counterfeit ink cartridge has been detected, the printer will operate in safe mode.

HP is unable to warrant the performance of the printing system when operated outside of environmental 
specifications or when a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to 
protect the printer and the printheads from damage due to unexpected conditions, and is in operation 
when the icon is displayed on the printer’s control panel and by the Embedded Web.

For optimal performance, use original HP ink cartridges. HP DesignJet printing systems, including 
original HP inks and printheads, are designed and engineered together to provide uncompromising print 
quality, consistency, performance, durability, and value—with every print.

NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove the 
continuous ink system and install genuine HP (or compatible) cartridges.

NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges 
prior to depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine 
HP or compatible) to continue printing.

NOTE: This printer is intended to work only with cartridges that have a new or reused HP chip, and it 
uses dynamic security measures to block cartridges using a non-HP chip. Periodic firmware updates 
will maintain the effectiveness of these measures. More on the HP website at the following link: 
http://www.hp.com/learn/ds.
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Maintaining the printer11

Checking printer status and maintenance are essential to keep your equipment in prime condition. 
Keep your printer clean, diagnose issues, calibrate, replace the printhead when required, and keep your 
software up to date.

Check printer status
There are various ways you can check the current printer status.

1. From the control panel, you can get information about the loaded paper and the ink levels.

2. If you access the Embedded Web Server, you see information about the general status of the 
printer.

Take care of the printer
The printer is not designed for any purpose other than printing.

It is not recommended to use the printer as a table, for two reasons:

● The surface can easily be damaged.

● Anything that falls into the printer can cause more serious damage.

Clean the exterior of the printer
Clean the outside of the printer and all other parts of the printer that you regularly touch as part of 
normal operation with a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before 
you clean it. Do not let water get inside the printer.

CAUTION: Do not use abrasive cleaners on the printer.

Print Quality Diagnostic Report
There are two test patterns designed to highlight printhead reliability problems.
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To print the Print Quality Diagnostic Report
Check the performance of the printhead that is currently installed in your printer, and whether it suffers 
from clogging or alignment problems.

1. Use the same paper type that you were using when you detected a problem. The test patterns are 
easiest to evaluate on plain white paper.

2. Check that the selected paper type is the same as the paper type loaded into the printer. See View 
information about the paper on page 32.

3. From the printer's control panel, tap the Menu icon , then Tools > Reports > Status Reports > 
Print Quality Diagnostic Report.

NOTE: The report can also be requested from the Embedded Web Server.

Test patten 1: If the lines are not straight and connected, align the printhead. See Align the printhead on 
page 87.

Test patten 1: If you see thin white lines across and of the colored blocks, clean the printhead. See Paper 
handling on page 22.

Corrective actions
If you have an issue with the diagnostic page, there are steps you can take, depending on the problem.

1. If the lines in Test Pattern 1 are not straight and connected, align the printhead (see Align the 
printhead on page 87).

2. If any of the colored blocks in Test Pattern 2 show white lines, are faded or completely missing, 
clean the printhead (see Clean the printhead on page 86). Follow the control-panel prompts and 
perform all three levels of cleaning if necessary.

3. If the problem remains, clean the printhead again.

4. If the problem remains, replace the printhead (see Replace the printhead on page 87). If the 
printhead is still in warranty, contact HP Support (see Contact HP Support on page 170).

Clean the printhead
If your print is streaked or has incorrect or missing colors, the printhead may need to be cleaned.

There are three stages of cleaning (Express, Basic and Advance). Each stage lasts about two minutes, 
uses one sheet of paper, and uses an increasing amount of ink. After each stage, review the quality of 
the printed page. You should initiate the next phase of cleaning only if the print quality is poor.
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If print quality still seems poor after you complete all stages of cleaning, try aligning the printhead.

NOTE: Cleaning uses ink, so clean the printhead only when necessary.

NOTE: Failing to turn off the printer correctly can cause print-quality problems.

Clean the printhead from the control panel
When your print quality seems poor, and you are next to the printer, this is a simple method to address 
the issue.

1. Make sure there is paper in the input tray or a roll loaded.

2. Go to the control panel and tap the Menu icon , then Tools > Troubleshooting > Printhead 
Cleaning.

Align the printhead
Precise printhead alignment is essential for good area fill, line quality, and sharp edges in graphical 
elements.

Your printer has an automatic printhead alignment process which runs whenever a printhead has been 
accessed or replaced. You may need to align the printhead after a paper jam or if you are experiencing 
print-quality problems.

IMPORTANT: Load minimum A4 and latter size paper. Do not load them in landscape.

1. Load the paper you wish to use, see Paper handling on page 22. You can use a roll or a cut sheet; 
plain white paper is recommended.

CAUTION: Do not use transparent or semi-transparent paper to align the printhead.

2. Ensure that the window is closed, as a strong light source near the printer during printhead 
realignment can affect alignment.

3. From the control panel, tap the Menu icon , then Tools > Troubleshooting > Printhead Alignment.

NOTE: Printhead alignment can also be started from the Embedded Web Server (Print Quality > 
Tools > Printhead Alignment).

4. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment 
pattern.

5. The process takes about five minutes. Wait until the control-panel display shows the process 
complete before using the printer.

If the printer cannot complete the printhead alignment successfully, you may be asked to clean the 
printhead and try again.

Replace the printhead
When the printhead is out of ink or has an issue that cannot be fixed, you must replace it. After 
replacement, the printer will automatically perform a printhead alignment on the loaded paper.
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TIP: If you would like to perform the printhead alignment on a different paper (perhaps from the tray), 
you could change the paper before starting this procedure. Plain white paper is recommended. A4 and 
letter paper should not be loaded in landscape orientation.

1. Make sure the printer is turned on.

2. Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer 
from moving.

3. From the control panel, tap the Menu icon , then the Supplies icon , then Printheads > 
Replace Printhead. Follow the instructions on the control panel.

4. Open the main door.

5. Open the printhead door on the right-hand side of the printer.

6. Locate the tubes connector-lever to release the ink tubes.
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7. Raise the lever to release the tube connector and store the tubes connector on the tubes 
connector-holder in the printer door.

8. Locate the printhead lever.

9. Raise the lever to release the printhead.
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10. Remove the printhead, handling it with care to avoid getting ink on the connections.

11. Insert the new printhead.

12. Lower the printhead lever (white).

13. Insert the tubes connector into the printhead.
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14. Make sure that the tubes connector locks shut.

15. Close the printhead door.

16. Close the main door and follow the instructions on the control panel.

The control panel now recommends a printhead alignment.

The printer prepares the printhead for use.

NOTE: Do not open any covers during this process.

Cannot connect the tubes to the printhead
It is important that you are using the correct type of printhead, and that it is well placed in its slot.

1. Check that the printhead is correctly inserted. See Cannot insert the printhead on page 151 .
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2. Check that the tubes connector lever (blue) is up before connecting the tubes connector.

Clean the encoder strip
You can use a small damp cloth to remove unwanted residue.

1. Turn off the printer: Press the power key and unplug the power cable.

2. Using tap water and a small cloth that will not leave fibers in the printer, dampen the cloth and 
remove any excess water, so that the cloth is damp but not wet.

3. Open the main door.

4. Hold the cloth in an inverted U shape around the encoder strip and carefully wipe until no further ink 
residue appears on the cloth. Be very careful not to scratch the encoder strip with your fingernails 
or any other object. Make sure that you are holding the cloth correctly.

NOTE: Do not move the carriage away from the service station.

5. Close the main door.

6. Turn the printer on.

Recalibrate the paper advance
Accurate paper advance is important to image quality because it is part of controlling the proper 
placement of dots on the paper. If the paper is not advanced the proper distance between printhead 
passes, light or dark bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the control panel. When 
you select the type of loaded paper, the printer adjusts the rate at which to advance the paper while 
printing. However, if you are not satisfied with the default calibration of your paper, you may need to 
recalibrate the rate at which the paper advances. See Troubleshooting print-quality issues on page 116
to determine whether paper advance calibration will solve your issue.

Recalibrating the paper advance procedure
The recalibration procedure takes approximately three minutes.

TIP: It is recommended to only have the paper loaded that you want to calibrate.

1. From the control panel, tap the Menu icon , then Tools > Troubleshooting > Automatic Paper-
Advance Calibration. When prompted by the control panel, confirm the paper source and type. 
The printer automatically recalibrates the paper advance and prints a paper advance calibration 
image.

2. Wait until the control panel displays the status screen and re-print your print.

NOTE: Do not worry about the paper advance calibration image.
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If you are satisfied with your print, continue using this calibration for your paper type. If you see 
improvement in your print, continue with the next step. If you are dissatisfied with the recalibration, 
return to the default calibration, see Return to default calibration on page 93.

3. If you would like to fine tune the calibration, or are using a transparent paper, swipe down the 
dashboard and tap the Menu icon , then Tools > Troubleshooting > Adjust Paper Advance.

4. Select the percentage of change from –99% to +99%. To correct light banding decrease the 
percentage. To correct dark banding increase the percentage.

5. To save the value, tap OK on the control panel.

6. Wait until the control panel displays the status screen and reprint your print.

Return to default calibration
This sets all the corrections made by the paper advance calibration to zero. To return to the default 
paper advance calibration value, you must reset the calibration.

1. From the control panel, tap the Menu icon , then Tools > Troubleshooting > Reseat Ready paper.

2. Wait until the control panel displays the operation has completed successfully.

Clean the scanner scanbars
You are recommended to clean the scanbars periodically, depending on how often you use the scanner.

1. Turn off the printer using the power key, turn off the power switch and disconnect the power cable.

IMPORTANT: Make sure to turn off the printer before cleaning. It is important to allow the printer to 
restart after cleaning to solve any issues.

2. There are two small indented buttons at the front of the scanner. Press them to open the scanner 
cover.

WARNING! Be careful while the scanner lid is open. Your fingers or hand may be trapped or 
crushed.
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3. Lift the scanner cover.

4. Clean the scanner scanbars and the surrounding area with a lint-free cloth.

5. For more thorough cleaning, clean the calibration surfaces and the feed rollers.

6. Close the scanner cover and gently push it down to lock it into place.
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7. Clean the area immediately in front of the scanner, where the scanned sheet rests before scanning.

8. Reconnect the printer's power cable, turn on the power switch at the rear, and turn on the printer 
using the power key.

Calibrate the scanner
Your scanner has been calibrated at the factory, and theoretically CIS scanners do not need to be 
recalibrated during their lifetimes.

Nevertheless, because of environmental changes, your scanner may start showing image defects that 
can be easily corrected by recalibrating the scanner.

If you perform calibration successfully and still have concerns about the image quality, read 
Troubleshooting copy and scan quality issues (only MFP) on page 128 to decide whether you are facing a 
product limitation, and may want to consider buying a CCD scanner.

To calibrate the scanner
The whole procedure takes less than 10 minutes, and you are recommended to recalibrate the scanner 
whenever you see some undesired artifact or a lack of quality in scanned files or copies, bearing in mind 
the limitations of CIS technology already explained in this guide.

1. Clean the scanner. See Clean the scanner scanbars on page 93.

2. Go to the control panel, swipe down the dashboard and from the Menu, tap Tools, then 
Troubleshooting, Scan Quality, and then Scanner Calibration.

3. Follow the instructions in the control panel.

If calibration fails
Ensure that the printer is turned on and ready for normal operation.

1. Ensure that the scanner is working correctly. To test it, scan a small document to file.

2. Ensure that the scanner is clean before calibration. If in doubt, clean the scanner and restart the 
calibration process.

3. Eject and reload the calibration sheet, checking that it is clean, in good condition, face up and 
perfectly centered in the scanner.

4. If the above steps do not help, eject the sheet and restart the printer (turn off and on). When the 
system has restarted, repeat the calibration.

5. If you cannot perform the calibration successfully in three consecutive attempts, call HP support 
and report the error code that appears in the control panel. See Contact HP Support on page 170
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Move or store the printer
If you need to move the printer, take care to prepare it correctly to avoid possible damage.

To prepare the printer:

1. Do not remove the ink cartridges or printhead.

2. Make sure that no paper is loaded.

3. Turn off the printer using the Power key at the back.

4. Unplug the printer's power cord.

5. Disconnect any cables connecting the printer to a network or a computer.

CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious 
damage.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and 
prepare the printhead. Preparing the printhead normally takes just over a minute. However, if the printer 
has been off for a eight weeks or more, preparing the printhead could take up to a few minutes.

CAUTION: If the printer remains off for a long period of time, the printhead may become unusable. In 
this case, you need to replace the printhead with a new one.

Firmware update
The printer's various functions are controlled by firmware that resides in the printer.

From time to time firmware updates will be available from HP. These updates improve the printer's 
functionality, enhance its features, and may correct minor problems.

IMPORTANT: You are strongly recommended to update the firmware periodically in order to take 
advantage of the latest developments.

There are various ways of downloading and installing firmware updates; you can choose whichever you 
find most convenient. They can be divided into two categories: automatic and manual updates.

Automatic firmware updates
Automatic firmware updates are available for printers connected to the Web.

Your printer can automatically download the latest firmware release and install it for you.

IMPORTANT: Your printer must be connected to the Internet and the firmware update setting must be 
set to “Install updates automatically”.

To configure automatic firmware updates:

● From the control panel: Menu > Settings > Firmware Update.

● From the EWS: General > Firmware Update > Firmware update tap.

Once the printer detects that there is a new firmware available, follow the instructions on the control 
panel.
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Manual firmware updates (only MFP)
Manual firmware updates can be carried out using a USB flash drive.

1. Download the firmware file from the HP website. See Software update on page 97.

2. Copy the file into the USB flash drive and insert it into the Hi-Speed USB host port in the control 
panel.

3. Go to the control panel: Menu > Tools > Maintenance > Firmware and select Update from USB.

4. Select the downloaded firmware file and follow the instructions on the control panel.

Manual firmware updates (only non-MFP)
1. Download the software from the HP website. See Software update on page 97.

2. Run the downloaded software on your computer and follow the instructions.

Software update
Manual updates of printer drivers and other software are available for your printer.

Go to the HP website at the following links:

● HP DesignJet T850: https://www.hp.com/go/DesignJetT850/software

● HP DesignJet T850MFP: https://www.hp.com/go/DesignJetT850MFP/software

● HP DesignJet T950: https://www.hp.com/go/DesignJetT950/software

● HP DesignJet T950MFP: https://www.hp.com/go/DesignJetT950MFP/software

Printer maintenance kits
Two maintenance kits are available for your printer, containing components that may need to be 
replaced after long use.

When one of them is needed, a message is displayed on the control panel and you should contact 
HP Support (see Contact HP Support on page 170) and request the maintenance kit. The kits are 
installed by service engineers only.

HP Support Assistant
This helps you maintain your computer and printer. It helps you avoid or resolve issues.

The HP Support Assistant guides you to expert support when required and helps you maintain peak 
performance and resolve problems through automatic updates, built-in diagnostics, self-help, and a 
variety of assistance options. A wealth of information and support resources for your HP computers and 
printers is only a few clicks away.
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HP Support Assistant is pre-installed on HP computers sold after October 2012, running Windows 7, 
Windows 8, or Windows 10 operating systems.

NOTE: Features may vary depending on the version installed, your computer model, and your 
location.

HP Support Assistant can also be installed used on non-HP computers.

If HP Support Assistant is not installed on your computer running Windows 7, Windows 8, or Windows 10, 
you can download the latest version by selecting it on the printer driver, or from the HP website at the 
following link: http://www.hp.com/go/hpsupportassistant.
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Accessories12

Supplies and accessories can be ordered for your printer.

How to order supplies and accessories
There are two ways to order supplies or accessories for your printer.

● Visit the HP website at the following links: https://hp.globalbmg.com/ and https://www.hp.com/ on the 
Web.

● Contact HP Support (see HP Support Center on page 168).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies
Ink cartridges can be ordered singularly. There is also a printhead replacement kit you can order for your 
printer.

Ink cartridges

Cartridge Part number

HP 738 130ml Cyan DesignJet Ink Cartridge 498N5A

HP 738 130ml Magenta DesignJet Ink Cartridge 498N6A

HP 738 130ml Yellow DesignJet Ink Cartridge 498N7A

HP 738 130ml Black DesignJet Ink Cartridge 498N4A

HP 738B 130ml Black DesignJet Ink Cartridge 498P2A

HP 738 300ml Cyan DesignJet Ink Cartridge 676M6A

HP 738 300ml Magenta DesignJet Ink Cartridge 676M7A

HP 738 300ml Yellow DesignJet Ink Cartridge 676M8A

HP 738 300ml Black DesignJet Ink Cartridge 498N8A

HP 738B 300ml Black DesignJet Ink Cartridge 498P6A
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If you're using the Designjet XT 950

Cartridge Part number

HP 738M 300-ml Black DesignJet Ink Cartridge 498Q0A

HP 738M 300-ml Cyan DesignJet Ink Cartridge 676M9A

HP 738M 300-ml Magenta DesignJet Ink Cartridge 676N0A

HP 738M 300-ml Yellow DesignJet Ink Cartridge 676N1A

Printhead

Printhead Part number

HP 713 DesignJet Printhead Replacement Kit 3ED58A

The availability of supplies varies by region. Check your local HP website for the availability of supplies in 
your region.

If you are using an XT printer version, or a printer bought in the Asia-Pacific region, please check the 
compatibility of supplies with a trusted reseller.

Order paper
HP printers can use a wide range of paper types.

To check the saltest information related to papers supported by your printer, go to the HP website at the 
following link: http://www.hplfmedia.com.

Order accessories
Adding a second HP DesignJet Spindle will save you time loading and unloading rolls to a unique spindle. 
With the additional spindle, you have the next roll ready to load on your printer.

Accessories

Name Description Product 
number

Strategic Compatibility

HP DesignJet 
Sheet 
Organizer

Output pocket 
for tray sheets 
to be separated 
from LF pages.

698G7A Yes T850, T850 MFP

HP DesignJet 
Sheet 
Organizer & 
Stacker Kit

Combined 
output pocket 
for tray sheets 
and LF stacker.

698G8A Yes T850, T850 MFP

36-in Spindle 
T850

36-in Spindle 
for T850 (up to 
150ft roll).

B3Q37A No T850, T850 MFP

36-in Spindle 
T950

36-in Spindle 
for T950 (up to 
300ft roll)´.

7F2C8A No T950, T950 MFP
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Accessories (continued)

Name Description Product 
number

Strategic Compatibility

3-inch Core 
Adaptor

Accessory to 
load 3-inch rolls 
on a 2-inch 
spindle.

CN538A No T950, T950 MFP

Introduction to the accessories
You can increase your printer's possibilities with accessories.

Spindle
With extra spindles, you can quickly change from one paper type to another.

3-inch core
You can adjust the spindle's core to load 3-inch core paper rolls. Be aware that roll size cannot exceed 
the maximum diameter; 100 mm in T850 & 140 mm in T950).

Sheet organizer: (only T850)
You can collect A3 & sheet pages separately from large-format pages.

Sheet organizer & stacker kit
You can modify media output management to have pages stacked, in order and separated by size.
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Troubleshooting paper issues13

When the printer detects a jam, it tries to resolve the issue automatically. If it cannot, it stops, and you 
must fix the problem manually.

Paper cannot be loaded successfully
There are various reasons why you may have issues loading the paper.

● Ensure that no paper is already loaded.

● Ensure that the paper is far enough inside the printer, you should feel the printer grab the paper.

● Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the 
control-panel display. The printer automatically attempts to straighten the paper.

● The paper may be crumpled, or warped, or may have irregular edges.

Unsuccessful roll load
There are checks to make and steps to correct any problems.

● Check that the roll is at least 370 mm (14.5 in) wide: narrower rolls are not supported.

● Check the leading edge of the paper: if it is not straight or clean, it should be trimmed. Remove the 
initial 20 mm (1 in) from the roll and try again. This may be necessary even with a new roll of paper.

● Check that the roll ends are tight against the spindle ends.

● Check that the spindle is correctly inserted.

● Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.

● Check that all roll tapes have been removed.

● Check that the paper is wound tightly on the roll.

● Do not touch the roll or paper at during the final steps of the loading process.

If the paper has not been inserted straight, follow the instructions on the control panel.

If you would like to start the load process again, cancel the process on the control panel and rewind the 
roll from the end of the spindle until the edge is removed from the printer.

NOTE: If the roll has become loose around the core, the printer cannot load the paper.
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Unsuccessful sheet load
There are checks to make and steps to correct any problems.

● Check that the sheet is more than 210 mm (8.3 in) wide (A4).

● Guide the sheet, especially thick papers, when the printer initially feeds the sheet.

● Ensure that the sheet is aligned with the reference line on the roll cover.

● Do not attempt to straighten the sheet during the loading process, unless instructed to by the 
control-panel display.

● Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, follow the instructions given on the control-panel display.

If you would like to start the load process again, cancel the process on the control panel; the printer 
ejects the sheet from the front of the printer.

Unsuccessful load from the tray (only HP DesignJet T850)
There are checks to make and steps to correct any problems.

● Check that you have not loaded too many sheets into the tray. The maximum number of sheets 
depends on the paper thickness: around 50 sheets of plain, standard paper.

● Check that the sheets are correctly loaded into the tray.

● Check that the sheets are correctly adjusted and centered in the tray.

● HP DesignJet T850 36-in Printer only: Check that you have extended the input tray correctly: the first 
extension for A4, the second for A3 paper.

If the paper is hanging over the back of the input tray as shown, it may fail to load.

NOTE: Try to avoid leaving sheets of paper loaded in the printer for a significant length of time, 
because they will deform.

Unsuccessful sheet load 103



Paper loading error messages
There is a list of control-panel messages related to paper loading, with the suggested corrective action.

Error Messages

Control-panel message Suggested action

Paper loaded with too much skew During the paper load process the printer detected that the paper had too much 
skew. Tap OK to unload the roll automatically, then restart the process.

Paper not detected During the paper load process the printer did not detect any paper. Ensure the 
paper is inserted fully and is not transparent.

Paper too far from lateral edge Reload the cut sheet, aligning the right edge against the black stop on the spindle.

Paper load failed. Paper width is smaller 
than the minimum size supported by the 
selected paper source.

Cut sheets smaller than ISO A4 must be loaded using the tray.

Sheet too big During the load process the printer has detected that the sheet of paper is either 
too wide or too long to be loaded correctly. Tap the cancel icon  to stop the load 
process. See Functional specifications on page 172.

Sheet too small During the load process the printer detected that the sheet of paper is too narrow 
or too short to be loaded in the printer. Tap the cancel icon  to stop the load 
process. See Functional specifications on page 172 .

Paper type is not in the driver or control panel
To work with a paper type not present in the driver menu, you can identify the paper type as one of the 
presets already available in the driver, however, you must identify whether your paper is transparent or 
translucent, photo or bond, coated or technical.

NOTE: For glossy paper, it is important to select a glossy paper type, as the printer adjusts its use of 
ink for glossy paper.

Transparent or translucent film
You may use clear or matte film.

If your paper is a transparent film (for example, a transparency), select paper type Film > Transparent/
Clear film.

If your paper is a translucent paper or film (for example, technical paper), select paper type Film > Matte 
film.

Photo paper
If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select 
paper type Photo Gloss Paper. For Semi-gloss, Satin, Pearl, or Luster finishes, select paper type Photo 
Semi-gloss/Satin Paper.

Bond and coated or technical paper
Your paper type selection for generic paper depends on the paper’s ink absorption capacity.

● For natural tracing papers, select paper type Natural Tracing Paper < 65 g/m2 or Natural Tracing 
Paper > 65 g/m2, depending on the weight of the paper.
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● For thin papers (< 90 g/m2) or uncoated papers (for example plain paper or bright white paper), 
select paper type Bond and Coated Paper > Plain Paper.

● For light coated papers (< 110 g/m2), select paper type Bond and Coated Paper > Coated Paper.

● For heavyweight coated papers (< 200 g/m2), select paper type Bond and Coated Paper > 
Heavyweight Coated Paper.

● For matte paper, select paper type Polypropylene Matte or Adhesive Paper. For a gloss or satin 
paper, select paper type Adhesive Polypropylene Gloss.

Black ink is easily removed when touched
This happens when your paper is incompatible with matte black ink.

To use an optimized ink combination, select paper type Photo Paper > Photo Gloss Paper.

After printing, the paper has wrinkles or there is too much ink
This happens when too much ink is used.

To use less ink, select a thinner category. Matte paper categories from thinnest to thickest are:

● Plain Paper

● Coated Paper

● Heavyweight Coated Paper

For other print-quality problems, see Troubleshooting print-quality issues on page 116.

Printer printed on the wrong paper type
This happens when the printer prints your job before you were able to load your desired paper.

You may have Use printer settings selected for the Paper Type in the printer driver.

When Use printer settings is selected the printer will print immediately on whichever paper is loaded. 
Load your desired paper, see Paper handling on page 22, and select your paper type specifically in the 
driver.

● In the Windows driver dialog: Select your paper type from the Paper Type list.

● In the Mac OS X Print dialog: Select the Paper/Quality panel, then from the Paper Type list, select 
your paper type.

NOTE: Use printer settings is the driver default.

Paper mismatch
If the paper currently loaded in the printer is not suitable for a particular job, the printer stops and waits 
for you to decide what to do. There are several ways in which the loaded paper may be considered 
unsuitable.

● The paper type is not as specified for the job.

Black ink is easily removed when touched 105



● The paper source (roll, tray, or manual feed) is not as specified for the job.

● The paper size is smaller than specified for the job.

If you do not specify these things for a particular job, the printer will print on whatever paper is loaded.

If the printer stops for a paper mismatch, you can decide among the following alternatives:

● Load the correct paper and resume printing.

● Print the job on the already-loaded paper. The print may be clipped if the paper is not large enough.

● Cancel the job.

Cut-sheet doesn't enter or drops out of the sheet organizer
Ensure the correct paper-type settings are selected in the control panel in the tray tab. Ensure the paper 
guides in the tray are in the position that matches the paper size.

It is recommended to use long-grain orientation paper on a high ink volume document, as short-grain 
orientation paper has a tendency to curl and block the pocket's entrance, which causes documents to 
fall to the floor.

It is not recommended to use non-plain stiff paper as it can stop the paper from entering the sheet 
organizer, causing it to drop to the floor.

Roll has jammed
When a paper jam occurs, you normally see a message about it in the control-panel display.

1. Open the roll cover.

2. Open the main door.
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3. Rewind the roll to create a loop. Cut the paper, if needed.

4. Carefully remove any of the jammed paper that you can from the top of the printer.

5. Carefully remove any of the jammed paper from the front window. 

6. Reload the roll, or load a new sheet; see Paper handling on page 22.

NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the 
procedure and carefully remove all pieces of paper. You may need to remove the tray (see Tray has 
jammed (HP DesignJet T850) on page 107 or Tray has jammed (HP DesignJet T950) on page 108
depending on your model).

Tray has jammed (HP DesignJet T850)
Paper can jam in the tray for a variety of reasons and there are steps to follow to correct an issue.

Proceed as follows:

1. Remove as much paper as you can from the tray.

2. Push down the tray extensions, which will make the tray easier to handle.
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3. Unlock the tray, using the rotary switch behind it.

4. Pull out the tray.

5. Remove all paper from the tray.

6. Put the tray in again.

7. Lock the tray.

Tray has jammed (HP DesignJet T950)
Paper can jam in the tray for a variety of reasons and there are steps to follow to correct an issue.

Proceed as follows:
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1. At the back of the printer, release the cleanout-tray cover by pushing the two buttons inwards.

2. Remove the cleanout-tray cover.

3. Remove all the paper.

4. Put the cleanout-tray cover in again, and check it is locked into place.

5. At the front of the printer, pull out the tray.

6. Remove all the paper from the tray.
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7. Put the tray in again.

The paper has jammed in the scanner
The following steps provide the complete procedure for this topic.

When a paper jam occurs, a message about it appears in the front-panel display.

1. Open the scanner cover.

2. At the back, pull the media out from the top rear area.
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Or pull it from the front bottom area between the scanner platen and front window.

CAUTION: Do not move the paper sideways; it could damage the scanner!

Or pull it from the front bottom area between the scanner platen and front window.

3. Turn the rubber wheels with a finger in order to get better access to the paper, and remove any 
debris.

4. Close the scanner lid.

A strip stays on the output area and generates jams
If a small piece of paper has been cut, such as before printing a new roll, or after the Move and Cut 
control panel option has been used, the cut strip may remain in the output area. Make sure that the 
printer is not printing, then reach into the area and remove the strip.
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Printer displays out of paper when paper is available
If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. 
If possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the bin
There are steps you can follow if there is an issue with the bin.

● Ensure the bin is correctly installed.

● Ensure the bin is open.

● Ensure the bin is not full.

● Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or 
remove prints manually as they are completed.

Change stacker from default to regular bin style configuration
Switching between the two configurations is an simple four-step process.

If the output is not stacked properly, you can try changing from default to regular bin style configuration. 
In this position, the stacker acts as a normal basket instead. The basket can accept up to 10 A1 or 
ANSI D-sized sheets of bond paper. Larger prints should be removed from the basket immediately after 
printing.

1. Position both front and back boards in the down position.
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2. Lift and transfer the stacker to the lower slot position, ensure only the top pole is inserted onto the 
lower of the left and right semi circular slots.

3. Check to see if the transfer is correctly done, the bottom pole should be visible and free to rotate 
upwards.

4. Hold down one end of the bottom to prevent it from rotating before lifting the front board into the up 
position. This completes the regular bin style configuration.
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Sheet stays in the printer when the print has been completed
The printer holds the paper to allow the print to dry after printing.

See Change the drying time on page 33. If the paper is only partially ejected after the drying time, gently 
pull the sheet out of the printer. If the automatic cutter is disabled, use the Form feed and cut option in 
the control panel, see Advance button and cut button on page 33.

Paper is cut when the print has been completed
By default the printer cuts the paper after the drying time has been completed. You can disable the 
cutter.

See Change the drying time on page 33. You can disable the cutter, see Turn the automatic cutter on and 
off on page 33.

Cutter does not cut well
By default, the printer is set to cut the paper automatically after the drying time has been completed.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any 
obstacles, and check that there are no pieces of paper in the cutter groove.

If using the driver, make sure that the cutter is not disabled in the print options.

Scanner does not load original
If you have difficulty loading, first check that the scanner is on, and then follow the steps in order to 
check and fix any issue.

1. Wait until the scanner has started up completely and is idle.

2. Check for messages on the front panel.

3. If you completed the above steps, check that the original meets the scanner specifications.

4. Make sure you are loading the original far enough into the scanner so that it can be detected.

5. Make sure the leading edge of the original is flat and the leading edge is even when loading it. If not, 
trim the leading edge so that the paper enters the scanner smoothly.

6. Try using a different paper type to exclude that the problem is caused by a scanner hardware issue.

Cannot connect the tubes to the printhead
It is important that you are using the correct type of printhead, and that it is well placed in its slot.

1. Check that the printhead is correctly inserted. See Cannot insert the printhead on page 151 .

114 Chapter 13  Troubleshooting paper issues



2. Check that the tubes connector lever (blue) is up before connecting the tubes connector.
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Troubleshooting print-quality issues14

Step by step instructions are provided for you to identify and resolve your issue.

General printing advice
To achieve the best performance from your printer, use only genuine manufacturer's supplies and 
accessories.

● Genuine manufacturer's supplies and accessories have been thoroughly tested to give trouble-free 
performance and best-quality prints. For details of recommended papers, see Order paper on page 
100.

● Make sure that the paper type selected in the control panel is the same as the paper type loaded 
into the printer (see View information about the paper on page 32). Also make sure that the paper 
type selected in your software is the same as the paper type loaded into the printer. See Paper type 
is not in the driver or control panel on page 104 if you have doubts about the paper selection.

CAUTION: If you have the wrong paper type selected, you could experience poor print quality and 
incorrect colors, and perhaps even damage to the printhead.

● Check that you are using the most appropriate print-quality settings for your purposes (see Printing 
on page 35). You are likely to see lower print quality if you have set the quality level to Fast.

● Check that your environmental conditions (temperature, humidity) are in the recommended range. 
See Environmental specifications on page 175.

Horizontal lines across the image (banding)
If your printed image suffers from added horizontal lines as shown (the color may vary).

1. Check that the paper type you have loaded corresponds to the paper type selected in the control 
panel and in your software. If you have doubts about the paper selection, see Paper type is not in 
the driver or control panel on page 104.
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2. Check that you are using appropriate print-quality settings for your purposes (see Printing on 
page 35). In some cases, you can overcome a print-quality problem merely by selecting a higher 
print-quality level. For instance, if you have set the Print Quality level to Fast, try setting it to Best.

3. Print the Print Quality Diagnostic Report. See To print the Print Quality Diagnostic Report on page 
86.

4. If no issues were found in the Print Quality Diagnostic Report, but you still see white horizontal lines 
or white streaks in your image, clean the printhead, making sure you complete all phases of the 
cleaning process right until the end (see Clean the printhead on page 86).

5. If the printhead is working correctly, perform paper advance calibration: see Recalibrate the paper 
advance on page 92.

If the problem persists despite all the above actions, contact your customer service representative for 
further support.

Lines are too thick, too thin, or missing
Check the paper type and settings, and run a report.

1. Check that the paper type you have loaded corresponds to the paper type selected in the control 
panel and in your software. If you have doubts about the paper selection, see Paper type is not in 
the driver or control panel on page 104.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 
35). If available for your paper, try turning on the Maximum detail option (under the Print quality 
setting).

3. If lines are too thin or missing, print the Print Quality Diagnostic Report. See To print the Print 
Quality Diagnostic Report on page 86 .

4. If the problem remains, perform a paper advance calibration: see Recalibrate the paper advance 
on page 92.

If the problem persists despite all the above actions, contact your customer service representative for 
further support.
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Lines appear stepped or jagged
Check your original image, and print-quality settings.

1. The problem may be inherent in the image. Try to improve the image with the application you are 
using to edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 35.

3. Turn on the Maximum detail option (under the Print quality setting).

Lines print double or in the wrong colors
This problem can have various visible symptoms.

● Colored lines are printed double, in different colors.

● The borders of colored blocks are wrongly colored.

To correct this kind of problem, print the Print Quality Diagnostic Report, and align the printhead if 
recommended in the report. See To print the Print Quality Diagnostic Report on page 86.

Lines are discontinuous
Check your print-quality settings and print a Print Quality Diagnostic Report.
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1. Check that you are using appropriate print-quality settings. See Printing on page 35.

2. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See 
To print the Print Quality Diagnostic Report on page 86.

Lines are blurred
Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy.

Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality 
printing. See Environmental specifications on page 175.

2. Check that the paper type selected in the control panel is the same as the paper type you are 
using. See View information about the paper on page 32.

3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper.

4. Select a higher print quality (such as Normal or Best), the printer will then use more time to dry ink.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the 
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper.

6. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See 
To print the Print Quality Diagnostic Report on page 86.

Line lengths are inaccurate
If you have measured your printed lines and find that the lengths are not sufficiently accurate for your 
purposes, you can try to improve line length accuracy.

Try the following:

1. Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional 
specifications on page 172.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is 
thinner or thicker than HP Matte Film will reduce line length accuracy.
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2. Set Print Quality to Best.

3. Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).

4. Load the roll of film and let it rest for five minutes before printing.

5. If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance 
on page 92.

Whole image is blurry or grainy
There are a series of steps and checks you can make to deal with this issue. Check the paper, settings, 
run reports to find the issue etc.

1. Check that the paper type you have loaded corresponds to the paper type selected in the control 
panel and in your software. If you have doubts about the paper selection, see Paper type is not in 
the driver or control panel on page 104.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 35). In some 
cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For 
instance, if you have set the Print Quality to Fast, try using Best.

4. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See 
To print the Print Quality Diagnostic Report on page 86.

5. If the problem remains, perform a paper advance calibration: see Recalibrate the paper advance 
on page 92.

If the problem persists despite all the above actions, contact your customer service representative for 
further support.

Paper is not flat
If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to 
see defects in the printed image, such as vertical stripes. This can happen when you use thin paper that 
becomes saturated with ink.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the control 
panel and in your software. If you have doubts about the paper selection, see Paper type is not in 
the driver or control panel on page 104.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.

3. Select a lower print quality (such as Fast); the printer will then use less ink.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the 
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper.

Print is scuffed or scratched
Pigmented ink can be scuffed or scratched when touched by a finger, a pen or some other object. This is 
particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the bin or to anything else that it contacts soon after 
printing, depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:

● Handle prints carefully.

● Avoid stacking prints on top of each other.

● Increase the drying time. At the control panel, tap the Menu icon, then Settings  > General > Extra 
Dry Time.

Ink marks on the paper
This problem can occur for several different reasons.

Horizontal smears on the front of coated paper
If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the 
printhead moves over the paper, the printhead may come into contact with the paper and smear the 
printed image.
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Whenever you notice this problem, cancel the printing job immediately. Soaked paper can damage the 
printhead.

If you notice poor print quality after this has happened, clean the printhead. Clean the printhead on page 
86.

1. Check that the paper type you have loaded corresponds to the paper type selected in the control 
panel and in your software. If you have doubts about the paper selection, see Paper type is not in 
the driver or control panel on page 104-.

2. Use a recommended paper type (see Order paper on page 100) and the correct print settings.

3. If you see that the paper wrinkles, it is most likely because the paper is too thin. Try changing to a 
thicker paper type such as HP Heavyweight Coated Paper.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the 
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper.

5. Try to increase the margins by relocating the image to the center of the page using your software 
application.

Ink marks on the back of the paper
Clean the platen with a soft cloth. Clean each rib separately.

Black ink comes off when you touch the print
This problem may be caused by printing with matte black ink on glossy paper. The printer will not use 
matte black ink if it knows that the paper will not retain it.

To be sure of avoiding matte black ink, you can select Photo Glossy Paper as the paper type (in the Photo 
Paper category).

Edges of objects are stepped or not sharp
If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the 
print-quality slider to Best, try setting print quality to Normal.
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Check that you are using appropriate print-quality settings. See Printing on page 35 for more 
information.

If the problem still persists, try rotating the image.

Edges of objects are darker than expected
You might see darker edges in some areas of the plot that cause local color variations. Try setting print 
quality to Best.

See Printing on page 35 for more information.

If the problem still persists, try rotating the image.

Vertical lines of different colors
If your print has vertical bands of different colors along it try changing the paper and/or adjusting the 
print-quality settings.

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight 
Coated Paper. See Order paper on page 100.

2. Try using higher print-quality settings (see Printing on page 35). For instance, if you have set the 
Print Quality to Fast, try setting it to Best.

White spots on the print
You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating 
material.

To avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or 
particles.

2. Always keep the cover of your printer closed.

3. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate
If the colors of your print do not match your expectations, there are steps you can take.

Try the following:
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1. Check that the paper type you have loaded corresponds to the paper type selected.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings. For the most accurate colors, select 
Normal or Best quality.

4. If using glossy paper, check that you are using the supported paper type. See Order paper on page 
100 and ensure the glossy paper is compatible with pigment inks.

5. Print the Print Quality Diagnostic Report. See To print the Print Quality Diagnostic Report on page 
86.

Colors are fading
Lamination will increase the life of prints (depending on the type of lamination) with all paper types.

Check you are using a recommended paper type (see Order paper on page 100). For more information 
about lamination, consult your laminate provider.

Image is incomplete (clipped at the bottom)
If the image is incomplete you may have cut the data being received, or there could be a communication 
issue.

● Did you tap Cancel before all the data were received by the printer? If so, you have ended the data 
transmission and will have to print the page again.

● There may be a communications problem between your computer and the printer. Check your 
network cable, or your Wi-Fi connection.

● Check to make sure that your software settings are correct for your current page size (for example, 
long-axis prints).

● If you are using network software, make sure it has not timed out.

Image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and 
the printable area as understood by your software.

● Check the actual printable area for the paper size you have loaded.

printable area = paper size – margins (5×5×5×5 mm0.2×0.2×0.2×0.2 in)
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● Check what your software understands to be the printable area (which it may call "printing area" or 
"imageable area"). For example, some software applications assume standard printable areas that 
are larger than those used in this printer.

● If you have defined a custom page size with very narrow margins, the printer may impose its own 
minimal margins, clipping your image slightly. You may want to consider using a larger paper size.

● If your image contains its own margins, you may be able to print it successfully by using the Clip 
Contents by Margins option (see Select margins options on page 38).

● If you are trying to print a very long image on a roll, check that your software is capable of printing an 
image of that size.

● You may have asked to rotate the page from portrait to landscape on a paper size that is not wide 
enough.

● If necessary, reduce the size of the image or document in your software application, so it fits 
between the margins.

Some objects are missing from the printed image
Large quantities of data may be necessary to print a high-quality large-format print job, and in some 
specific workflows there may be issues that can lead to some objects missing from the output.

Here are some suggestions to help you to avoid this problem:

● Select a smaller page size and scale to the desired final page size in the driver or in the control 
panel.

● Save the file in another format, such as TIFF or EPS, and open it with another application.

● Reduce the resolution of bitmap images in your application software.

NOTE: If you're using Adobe applications, ensure that you have installed the latest version.

These options are suggested for troubleshooting purposes and may adversely affect the final output 
quality or the time necessary to generate the print job. Therefore, they should be canceled if they do not 
help to solve the problem.

How to avoid further issues
There are things you can do to help avoid future issues, or to try if you still haven't found a solution to an 
problem you are experiencing.

● Try using a higher print-quality option. See Printing on page 35.

● Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about 
the issue, or better still; and if feasible, try using the correct HP driver. You can download the latest 
HP drivers from the HP website. See Printer solutions on page 8.

● Regularly update the firmware in your printer.

● Always check that you have the correct settings in your software application.
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Troubleshooting scanner issues15

Cannot access the network folder
Make sure your computer is using the same network as the printer. If it is, then follow the suggested 
checks to correct any issue.

If you have set up a network folder (see Scan to network setup process on page 55), but the printer 
cannot access it, try the following suggestions:

● Check that you have filled in each field correctly.

● Check that the printer is connected to the network.

● Check that the remote computer is switched on, working normally and connected to the network.

● Check that the folder is shared.

● Check that you can put files into the same folder from a different computer on the network, using 
the printer's logon credentials.

● Check that the printer and the remote computer are in the same network subnet; if they are not, 
check that the network routers are configured to forward the CIFS protocol traffic (also known as 
Samba).

Scanning to file is slow
Scanning large formats creates large files. This means that scanning to file can take time even under 
optimal system configurations and conditions.

This issue is especially true when scanning across a network. However, if you think scanning to file with 
your system is unreasonably slow, the following steps may help you to locate and solve the problem:

1. Use the control panel to check the status of your scan job. If it is taking an intolerably long time, you 
can cancel it.

2. Check that the Resolution setting is right for the job. Not all scanning tasks require high resolutions. 
If you lower the resolution, you will speed up the scanning process. For JPEG and PDF scan jobs, 
you can also change the Quality setting. Lower quality values produce smaller files.

3. Check your network configuration. Your network should be a Gigabit Ethernet or one of a higher 
transfer rate in order to achieve optimal scanning speeds. If your network is a 10/100 Ethernet 
configuration, you can expect slower transfer of the scan data and thus slower scanning speeds.
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4. Contact your network administrator for information about your network configuration, transfer 
rates, scan-to-file destinations on the network and possible solutions for increasing the speeds.

5. If scanning to files on the network is too slow and the network configuration cannot be amended to 
correct this, improved speeds can be achieved by scanning to a USB flash drive.

6. If scanning to a USB flash drive seems slow, check your USB flash drive interface compatibility. 
Your system supports a Hi-Speed USB interface. Your USB flash drive should be compatible with 
Hi-Speed USB (sometimes known as USB 2). Also check that your USB flash drive contains enough 
storage space for scanned large-format images.

Original document is reloaded while scanning
It may happen that, while scanning, the original document is accidentally loaded back into the scanner, 
causing a loop.

If this happens:

1. Open the scanner lid.

2. Carefully remove the original document.

3. Close the lid.

4. Check that the refeed preventers are correctly installed.

The refeed preventers are designed to prevent this situation from occurring. Make sure that they 
are always installed.
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Troubleshooting copy and scan quality 
issues (only MFP)

16

A defect is a common image artifact that usually appears when using any CIS scanner. These are due to 
incorrect settings, product limitations, or easily solvable mistakes. A failure mode is due to malfunctions 
of some of the scanner components.

In this chapter the most common defects and failure modes are shown, sorted by relevance and 
frequency of appearance.

Scanner cleanliness is paramount to ensure good image quality. Before proceeding with any 
troubleshooting, make sure the glass scanbars are clean and in good condition and the pressure sliders 
(wide, white plastic parts) are also in good and clean condition. See Clean the scanner scanbars on 
page 93.

Some of the corrective actions proposed here require the use of the scanner diagnostic plot, which 
you can print and scan as indicated in The scanner diagnostic plot on page 145. When copying, to be 
sure that the defect does not come from the printing function, use this diagnostic plot to detect any 
scanning issue. Do not use any printed version of this guide to test the scanner, as the resolution of the 
images included here is insufficient. Use the diagnostic plot when recommended in response to any of 
the errors described in this chapter.

Random vertical lines
This is one of the most common issues in sheet-fed scanners. Usually, the vertical streaks are caused by 
dust particles inside the scanner, or miscalibration of the scanner (in these cases, the problem can be 
solved).

Here are some examples of images suffering from vertical lines or streaks:

NOTE: The black arrow indicates the scanning direction.

1. Clean the scanner’s glass scanbars and the original to be scanned as described in Clean the 
scanner scanbars on page 93. Restart the printer and re-scan your original afterwards.
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2. If the streaks remain, recalibrate the scanner as indicated in Calibrate the scanner on page 95. 
Restart the scanner and re-scan your original after the calibration is completed.

3. If the streaks still remain, check the scanner’s glass scanbars and sliders visually. If they are 
damaged (scratched or broken), call HP support.

NOTE: The problem of vertical streaks cannot always be solved, due to the technological limitations 
of CIS technology. If the streaks remain after the corrective actions explained above, then no further 
action can be taken to improve the image quality, except to buy a more expensive CCD scanner. HP 
offers HD Scanners with CCD technology for customers with higher quality requirements.

Wrinkles or folds
Scanners based on CIS technology have a high optical resolution within their focus plane, at the price 
of a very limited depth of field. Hence, the images are sharp and detailed when the scanned original is 
perfectly flat against the glass plate.

However, whenever the original contains wrinkles or folds, these defects are clearly visible in the 
scanned image (as shown in the following example):

1. Re-scan the original and set the background color and noise removal to Off. If copying, set the 
content type to IMAGE.

2. If the problem persists, re-scan the original at a lower scanner resolution (300 dpi or lower 
resolution if scanning, Fast or Normal if copying). It may also help to flatten the original manually as 
much as possible before scanning it again.

NOTE: The problem of wrinkles cannot always be solved, due to the technological limitations of CIS 
technology. HP offers HD Scanners with CCD technology for higher quality requirements. If the 
wrinkles remain after the corrective actions explained above, then no further action can be taken to 
improve the image quality, except to buy a more expensive CCD scanner.

Line discontinuities
When scanning or copying large originals, you may sometimes find issues such as that shown in the 
following image, where a straight line (it does not necessarily have to be horizontal) appears with 
discontinuities or small steps.

NOTE: The black arrow indicates the scanning direction.
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1. Repeat the scan, making sure that the product is correctly positioned: it is flat on the floor and it 
does not move. Turning the original 90 or 180 degrees and scanning it again may also solve the 
problem.

2. If the problem persists, check that the original to be scanned is not skewed, and that it does 
not become skewed during the scan. If so, see Incorrect paper advance, skew during scanning, 
or horizontal wrinkles on page 139. You might also want to deactivate the automatic de-skew 
algorithm as indicated in A copied or scanned image is very skewed on page 144.

3. If there is no skew but the problem persists, clean and calibrate the scanner as indicated in Clean 
the scanner scanbars on page 93 and Calibrate the scanner on page 95. Take care not to move the 
printer during the calibration, and check that the maintenance sheet is correctly positioned before 
starting the calibration. Also check that the maintenance sheet is not damaged before calibrating 
the scanner (an old or damaged maintenance sheet may cause this problem); if it is damaged, 
reprint it as explained in Calibrate the scanner (see Calibrate the scanner on page 95).

4. If the problem persists, proceed to analyze the following areas of the diagnostic plot:

■ D, H and L (for three modules, 0-Left, 1-Middle, and 2-Right and its intersection)

If you see any of these defects in the studied areas, call HP support and report a “line 
discontinuities” error after calibration.

The four vertical thin black lines at the beginning and the end of the diagnostic plot show, approximately, 
the position of the intersection between scanbars, where this kind of error usually appears. If the error 
appears outside these areas, call HP support and report “line discontinuities within a scanbar”.

Light-colored area fills are missing in the scan or copy
When scanning or copying a map with a light area at the top, the Background color removal setting could 
interpret it as a background color, therefore removing it and other similar areas.

In the example below the original is on the left, the scanned image on the right:
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1. Repeat the scan or copy with Background color removal set to Off, or, in the case of copying, you 
can select Image as the content type. See Scan settings on page 53 and Copy settings on page 65.

2. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 93 and Calibrate the scanner on page 95. Repeat it again with Background color removal 
set to Off.

Grain in area fills when scanning plain paper
When making copies of an original containing area fills, if the paper used in the printer is plain paper (for 
instance, HP Universal Bond or HP Bright White Inkjet Bond), some grain may appear in the image.

This error may also appear in scanned files of originals that were printed on textured paper.

In the example below the original is on the left, the scanned image on the right:

1. Look at the original and check whether it is dirty, has fingerprints on it, or has grain already present 
in the print. If not, then proceed to step 2.

2. If it is a copy, repeat it, setting the content type to Image.

3. If the problem persists:

● If the problem appears when copying, use Best quality. We also recommend using coated or 
glossy paper in order to avoid grain in copies.

● If the problem appears in a scanned file, scan at a lower resolution (300 dpi or lower resolution).

4. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 93 and Calibrate the scanner on page 95. Check that the maintenance sheet is also clean, 
and that it is not damaged before calibrating the scanner (an old or damaged maintenance sheet 
may cause this problem); if it is damaged, reprint it as explained in Calibrate the scanner (see 
Calibrate the scanner on page 95).
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5. If the problem persists, proceed to analyze areas I and J of the diagnostic plot across modules =, 1 
and 3. In the three examples below, the top example is ideal, the middle example can be regarded as 
acceptable; but, if you see something similar to the bottom example (or worse), call HP support and 
report “grain in area fills”.

Small color differences between adjacent scanbars
When scanning wide plots, sometimes slightly different colors can be seen at both sides of the junction 
between two scanbars. This issue, if present, can be easily seen by analyzing patterns A and G of the 
diagnostic plot at the intersection between scanbars.

Here are some examples:

NOTE: The black arrow indicates the scanning direction.

Sometimes the color mismatch between adjacent modules can be enormous, showing a serious 
scanner malfunction, as in the following example. If this occurs, see Completely wrong colors on page 
141.
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1. Restart the scanner and repeat the scan or copy. If the problem persists, repeat the scan or copy, 
toggle the background color removal to Off or turning the original 90 degrees before scanning it 
again.

2. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 93 and Calibrate the scanner on page 95. If calibration ended without errors, try to scan or 
copy again.

3. If the problem persists, proceed to analyze patterns A and G in the diagnostic plot, if you see 
some color differences between left and right sides of the bars for neutral and vivid colors, call 
HP support and report “small color differences between adjacent ”. Otherwise, if you see color 
differences for vivid colors but not for neutral colors, see Clipping in dark or light areas on page 
136. If necessary, see also Grain in area fills when scanning plain paper on page 131.

Vertical light lines at the intersection between scanner 
scanbars

This problem can be found when scanning large uniform area fills which are made of some light color. 
You sometimes find light vertical bands (around 0.5 cm wide) at the intersection between two scanbars.

Example:

NOTE: The black arrow indicates the scanning direction.

1. Repeat the scan or copy, restarting the printer and setting the background color removal to Off or 
turning the original 90 degrees before scanning it again.

2. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 93 and Calibrate the scanner on page 95. Then proceed to analyze pattern number B of 
the diagnostic plot at the intersections between scanbars. The example below shows a good result 
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on the left and a bad result on the right: the latter has light vertical banding 0.5 cm wide at the 
intersection between two scanbars.

If you see the kind of result shown on the right, call HP support and report “vertical light bands in 
area fills at the intersection between scanbars, after calibrating the scanner”.

Variable line thickness or missing lines
When scanning some CAD plots at low resolution, mostly when working with grayscale or black-and-
white prints that contain very thin lines, you may see a variation in line thickness, or even some missing 
lines, in some places.

1. Repeat the scan or copy using a higher resolution (600 dpi). You should also toggle Background 
color removal to Off, or, for copying, set Content type to Mixed. You might also deactivate the 
automatic de-skew as explained in A copied or scanned image is very skewed on page 144. In case 
you were working in black-and-white mode, we recommend using grayscale instead.

2. If the problem persists, turn the original plot 90 degrees before scanning it again.

3. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 93 and Calibrate the scanner on page 95.

4. If the problem persists, see Defocus, blurring and fading colors on page 138.

Inaccurately reproduced colors
You have to deal with several variables if you want perfect color matching between the original you are 
scanning and the copy or scanned file you obtain as a result.

If you find undesired colors in cases, you can follow these guidelines.

In the example below the original is on the left, the scanned image on the right:
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1. When dealing with copies, you must take into account that good color matching between a given 
original and its copy can be achieved only if both are printed on the same type of paper. In the case 
of scanned files, good color matching can be achieved only if your monitor is color-calibrated or 
compliant with sRGB or AdobeRGB standards.

2. Restart the printer and scan or copy again.

3. If the above conditions are met, you should also take into account that various scanner settings 
can affect the final color result, such as lighter/darker, background color, noise removal, content 
type, and paper type. To obtain the best possible colors, set Darker/Lighter to Normal, Background 
color removal and Noise removal to Off, and Content type to Image (only if copying); and do not 
select Translucent paper. See Scan settings on page 53 and Copy settings on page 65.

4. For optimum color results, clean the scanbars (see Clean the scanner scanbars on page 93) and 
calibrate the scanner as indicated in Calibrate the scanner on page 95.

5. Avoid placing the scanner in direct sunlight or near sources of heat or cold.

Color fringing
The problem called “color fringing” occurs when the scanner is affected by incorrect paper advance 
and/or miscalibration. Nevertheless, some amount of color fringing is unavoidable, especially at high 
scanning speeds.

Color fringing can be seen at the borders of sharp black text over a white background.

In the example below the original is on the left, the scanned image on the right:

NOTE: The black arrow indicates the scanning direction.

1. Repeat the scan after increasing the scanner’s resolution (choose 300dpi or higher quality if 
scanning, Best if copying). Turn your original 90 degrees, if possible, before scanning it again.

2. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 93 and Calibrate the scanner on page 95.

3. If the problem still persists, you can diagnose this issue by analyzing the E patterns of the 
diagnostic plot. The black horizontal lines appear slightly colored at the top and bottom of each 
end (in the example on the right, below). Normally, they look red at the top and blue or green at the 
bottom, but it could be the other way around.

If you see this effect, call HP support and report “color fringing problem after calibration”.
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Clipping in dark or light areas
Sometimes you may see that the scanned file or copy of one of your plots has lost detail in light or dark 
areas (or both).

In the example below the original is on the left, the scanned image on the right:

Image © www.convincingblack.com, reproduced with permission.

1. If you are making copies, and the original is printed on photographic paper, while you are copying it 
onto matte paper, this problem is to be expected. However, you can try to restart the printer and set 
the background color and noise removal to Off and also change the Lighter/Darker settings; this 
also applies if you see this problem in scanned files.

2. If the problem persists, repeat the scan or copy using a higher resolution (300 dpi or higher if 
scanning, Normal or Best if copying). Set the content type to Image (if copying).

3. If the problem persists, recalibrate the scanner as indicated in Calibrate the scanner on page 95. 
Make sure you clean the maintenance sheet before calibrating the scanner, and check that the 
maintenance sheet is not damaged (if so, reprint it as explained in The scanner diagnostic plot on 
page 145. Re-scan your original after the calibration is completed.

4. If the problem persists, analyze patterns M (0, 1 and 2 modules) of the diagnostic plot. If you can 
distinguish lightness steps beyond the upper and lower specified thresholds, then the scanner is 
fine. Here you can see some examples of correct and incorrect functioning.

If your scanned pattern looks like the incorrect one on the right, whether the clipping is in dark 
and/or light areas, call HP support and report “Clipping in dark/light areas”.
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Flare in the image when scanning glossy originals
If the scanner is miscalibrated, or if the original plot you are trying to scan is very glossy or reflective, you 
can sometimes find flare in the scanned image.

In the example below the original is on the left, the scanned image on the right:

Image © www.convincingblack.com, reproduced with permission.

1. Clean the original and the scanner’s glass plate, then scan again. See Clean the scanner scanbars 
on page 93

2. If the problem persists, recalibrate the scanner as indicated in Calibrate the scanner on page 95. 
Re-scan your original after the calibration is completed.

3. If the problem persists, see Clipping in dark or light areas on page 136.

Vertical red and green bands over white or black background
If the scanner has not been calibrated for a long period of time, or if the last calibration failed, you can 
sometimes see defects.

Example:

NOTE: The black arrow indicates the scanning direction. The original is on the left, the scanned image 
on the right.

1. First, restart the printer and re-scan or copy. Clean and calibrate the scanner as indicated in Clean 
the scanner scanbars on page 93 and Calibrate the scanner on page 95. If the calibration failed, 
proceed as stated in Calibrate the scanner on page 95. However, if the calibration ended correctly, 
scan your original again and check that the colored vertical bands have disappeared.

2. If the problem persists, call HP support and report “vertical red/green bands after calibration”.

Vibration
If your printer is not properly placed on a flat surface, or if the scanner lid does not close correctly, you 
may sometimes find that the scanned image suffers from vibration.

In the example below the original is on the left, the scanned image on the right:

Flare in the image when scanning glossy originals 137



1. Make sure that the scanner is placed on a flat surface and the scanner lid is correctly closed. Scan 
your original again.

2. If the problem persists, change (increase or decrease) the scanning resolution and re-scan your 
original. We also recommend turning the original 90 degrees before scanning it again.

3. If the problem persists, analyze pattern D of the diagnostic plot. If you see the problem shown on 
the right, call HP support and report a “vibration problem”.

Defocus, blurring and fading colors
CIS technology scanners are tuned to work at a fixed focal distance, and they are very sensitive to small 
variations in the position of the original with respect to the scanner glass plate.

If the scanner lid is not properly closed, or if the original has deep wrinkles or texture, you may 
sometimes find problems as in the following example (on the right), where the scanned image is blurred 
and colors are faded:

1. Check that the scanner lid is properly closed. Open and close the scanner lid by pushing it down 
until you hear a click. Calibrate the scanner as indicated in Calibrate the scanner on page 95, then 
restart and repeat your scan.

2. If the problem persists, repeat the scan or copy using a higher resolution (300dpi or more if 
scanning, Normal or Best if copying). You should also set background color removal to Off, or set 
the content type to Mixed, if copying.
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3. If the problem persists, analyze pattern F in modules 0, 1 and 2 of the diagnostic plot. A correct 
example is given below, followed by two incorrect examples. Note that there is a black ring near 
the center of pattern F. In this step, you must look at the region near the black ring. If you can see 
discontinuities in the black and white lines, call HP support and report a “defocus or blurring” error.

Incorrect paper advance, skew during scanning, or horizontal 
wrinkles

You may encounter problems with some thick glossy originals being moved through the scanner’s paper 
path. In some cases, the original may become skewed during the scanning process.

If some of the paper rollers are not working correctly, you may find small horizontal wrinkles in the 
scanned image, due to the paper being stuck in some regions while not in others.

1. Turn your original 90 degrees and repeat your scan.
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2. If the problem persists, open the scanner lid. Clean the feed wheels (small black rubber) and 
the pressure sliders (wide white plastic). If you find dust particles or objects that obstruct the 
movement of the pressure sliders, try to remove them, then close the scanner lid and repeat your 
scan.

3. If the problem persists, restart the scanner by turning it off and on again. If you find an error 
message on the control panel during this operation, call HP support and report the error message. 
If no error message appears, try repeating your scan.

4. If the problem persists, analyze patterns D, K and L of the diagnostic plot. The plot should look like 
this:

If you see an image resembling the incorrect examples below, call HP support and report an 
“incorrect paper advance” problem.

Vertical black band 30 cm wide
Your scanner contains various scanner scanbars, each of which covers an area 30 cm (12 in) wide.

If one of the modules fails, and the scanner hardware check does not detect the failure, you may see a 
black vertical band, corresponding to the area covered by a single scanbar, in your scanned image or 
copy. Here is an example (on the right):

NOTE: The black arrow indicates the scanning direction.

Original Scan affected by a failing scanbar

1. Restart the scanner by turning it off and on again. If you find an error message on the control panel 
during this operation, call HP support and report the error message. If no error message appears, 
try repeating your scan.

2. If the problem persists, try to calibrate the scanner as indicated in Calibrate the scanner on page 
95. If this operation fails, call HP support with the error code given on the control panel. If no error 
code appears, try to repeat your scan.
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3. If the problem persists, call HP support and report a “vertical black band 30 cm wide”.

The scanner damages some originals
This scanner may cause vertical scratches on thick glossy paper printed on by inkjet printers.

Old prints or very thin tracing paper may also be damaged. This is because CIS technology requires the 
original to be held down with high pressure to obtain accurate results and avoid blurring and defocus 
problems.

If the original you intend to scan is valuable, and if it belongs to one of the types described above 
(inkjet-printed, thick, glossy original or old/thin/tracing paper original), HP recommends using a CCD 
scanner.

Completely wrong colors
If some of the LEDs used for illumination in the scanner scanbars are failing, or the last calibration did 
not work correctly, although no error message was given on the control panel, you may experience some 
completely wrong colors in your scanned images.

In the example below the original is on the left, the scanned image on the right:

1. Restart the scanner by turning it off and on again. If you find an error message on the control panel 
during this operation, call HP support and report the error message.

2. If no error message appears on the control panel during the restart process, try to calibrate your 
scanner, as indicated in Calibrate the scanner on page 95, once it is fully functional. If some error 
message appears on the control panel, call HP support and report the error, adding that you found 
it after seeing “completely wrong colors in the scanned image”.

3. If calibration succeeded, restart and repeat your scan, and check the colors.

4. If the colors are still wrong, analyze the whole diagnostic sheet. Check that you find completely 
wrong colors in the area corresponding to just one of the scanbars, as in the following figure. If so, 
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call HP support and report “completely wrong colors after calibration”, and report the letter of the 
scanbar that is failing (module A in the example).

If all the modules are failing, call HP support and report that.

Vertical distortion
If the lid sensor of the scanner fails, the scanner cannot detect when the lid is open. Hence, you can start 
a scan, and at some point find that the pressure sliders do not move the original through the scanner 
paper path.

In the example below the original is on the left, the scanned image on the right:

NOTE: The black arrow indicates the scanning direction.

■ Open and close the scanner lid by pushing it down until you hear a click. Then repeat your scan and 
visually check that the original advances correctly through the scanner path. If not, call HP support 
and report an “incorrect paper advance” error. Remember that your scanner is not intended to work 
with originals thicker than 0.75 mm (29 mil).

Object replication (ghosting)
This error very rarely appears in CIS scanners. However, you can occasionally find image defects.

In the example below the original is on the left, the scanned image on the right:
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Image © www.convincingblack.com, reproduced with permission.

1. Restart your printer. Then calibrate the scanner, as indicated in Calibrate the scanner on page 95, 
and repeat your scan. Turn the original 90 degrees if possible before re-scanning. You can also try 
modifying the Lighter/Darker setting.

2. If the problem persists, analyze pattern C, modules 0, 1 and 2, of the diagnostic plot. Call HP support 
and report an “object replication“ issue if you see the kind of error shown on the right.

Clipping or incorrect scale factor when down-scaling in copies 
and prints

When doing copies or prints (from USB, Embedded Web Server, or printer driver), the scaling setting is 
available with various possible options.

If you are experiencing problems related to border clipping, or it seems that your print has lost the 
scale-factor adjustment, read this section carefully in order to select the best value for the scaling 
setting in future jobs.

● Output scale: Custom (Precise scaling): In this case, the content of the original image is scaled 
by the percentage factor that you have selected. For example, in an original CAD image with a 
1:100 scale, if user selects scale to 50%, the printed plot will have an accurate scale of 1:200. 
Nevertheless, in the case of down-scalings when selecting a fixed percentage, some clipping of the 
marginal content of the plot may occur, as it is impossible for the printer to print up to the borders of 
the paper.

● Output scale: Standard sizes (Scale to fit into page size): In this case, the content of the original 
image is scaled by the percentage necessary to make sure that all the content is correctly printed 
and no clipping occurs. Nevertheless, in the case of down-scalings when selecting fit to page, the 
scale-factor adjustment may not be an integer divisor of the original. For example, in an original CAD 
plot with a 1:100 scale on A2 paper size, if user selects scale to fit on A3 paper size, the scaling 
factor will not be exactly 50% and the scale of the printed plot will not be 1:200 exactly. However, the 
plot will be printed completely without clipping any content.

Incorrect edge detection, mostly when scanning tracing paper
Tracing or translucent papers can be scanned with good results, although totally transparent papers are 
not supported.
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Nevertheless, the resulting image may have extra margins or some clipping of the content in some 
situations when detection of the edge of the paper is not accurate, which may also happen when 
scanning plain paper if the glass plate is dirty. In order to avoid these undesired effects, follow these 
recommendations.

1. Carefully clean the scanner’s glass plate and the original to be scanned with a cloth. Turn the 
original 90 degrees if possible and re-scan it afterwards. Remember to select Translucent as the 
paper type at the scanner if your original is translucent.

2. If the problem persists, calibrate your scanner, and re-scan your original again afterwards.

3. If the problem persists in the case of translucent paper, attach a sheet of white paper to the back of 
the original to be scanned.

A copied or scanned image is very skewed
Originals are often loaded into the scanner with some degree of skew. In order to correct for this 
unavoidable problem, the scanner has a built-in automatic de-skew algorithm, which measures the skew 
in the original and rotates the scanned image so that the result is perfectly straight.

However, in some cases the de-skew algorithm may increase the skew rather than correcting it. In other 
cases, the skew is so bad that it cannot be automatically corrected.

To load the original with minimum skew, grasp the original with the image facing up and your hands at left 
and right edges. You are recommended to avoid resting your hands or the original on the scanner's input 
tray. Push the original into the scanner insertion slot until you feel the whole top border of the original 
pressing against the scanner rubber rolls, which will load the original after a delay of 0.5 seconds. Now 
you can take your hands off the original. If you are not happy with the way the scanner has grabbed your 
original, you can touch the Eject icon  and try again.

The action of the automatic de-skew algorithm can be deactivated by touching the Settings icon , 
then Scan preferences or Copy preferences (you might want to deactivate it in one case but not in the 
other). You can also deactivate the automatic de-skew from the Settings button at every new scanner 
job.
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The scanner diagnostic plot17

You can print the plot onto a roll or a single sheet but do not use recycled or tracing paper.

Prepare the printer and the paper to print the diagnostic sheet
Turn on your printer and wait until it is functioning. Then select the paper on which the diagnostic plot is 
going to be printed (you can reuse the diagnostic plot at any time in the future, if it is saved carefully).

NOTE: Ideally, the diagnostic plot should be printed on Heavyweight Coated Paper; do not use 
recycled or tracing paper.

The size of the diagnostic plot is: 914 mm (36 in).

You can print on a roll or a single sheet, which should be of the maximum width accepted by the printer.

You can print the diagnostic plot from the control panel: tap the Menu icon , then Tools > 
Troubleshooting > Scanner Calibration > Start > Print.

Visual check for errors while printing the diagnostic sheet
Once the diagnostic plot is printed, the first step is to check that all the patterns included in it are 
correctly printed.

The diagnostic plot, if printed correctly, should look like this:

Some of the most common defects that may appear in a printed diagnostic plot are described below. 
If you find any of these problems, you should follow the recommended recovery procedure. See the 
Troubleshooting print-quality issues on page 116. Once the printer has been diagnosed and it is working 
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correctly, you can reprint the diagnostic sheet as described in Prepare the printer and the paper to print 
the diagnostic sheet on page 145.

Resolution
By looking at pattern F you may find problems with the printer’s resolution for the loaded paper. Usually, 
this test does not reveal a printer problem, but a defect in the paper, which may not be suitable for 
printing the diagnostic sheet with the required quality.

Here is what you should see if all is well, followed by two defective examples.

Alignment
Looking at patterns D, K, and L, you may find problems with the printer’s printhead alignment.

This can cause defects such as the following:
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Additionally, misalignment problems can be seen in patterns D and G in the form of color fringing (which 
is exaggerated below, on the right). That is, the limits between two strong colors are not well defined or a 
third color appears between them.

Finally, a special pattern for checking the printer’s printhead alignment can be found at the top left of the 
diagnostic sheet. This pattern has no number as it is not used for scanner checking. It is made of three 
colored crosses that may be used to identify the problem in question. The correct pattern is shown on 
the left, an example of misalignment on the right.

Loss of shadow or highlight details
Looking at pattern H, you may find a problem with the printer or the paper. If you can distinguish 
lightness steps beyond the upper and lower specified thresholds, then the printer is fine.

Here you can see examples of correct functioning on the left, incorrect on the right:

If the printer does not pass this test, you should check that you have correctly selected the paper type 
and the Best quality.

Printer banding
Looking at patterns A, B, and C, you may see vertical banding problems.

Example:
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See Horizontal lines across the image (banding) on page 116 for the troubleshooting steps to follow in 
this case.

Streaks
Looking at patterns A, B, C, G and H, you may find vertical streaks if the printer’s printheads are not 
working correctly. Replacing the printhead for the color showing the streaks may solve the problem.

Example:

Grain
Looking at patterns A, B, and C, you may find problems in the printer’s paper advance or the printheads 
that cause visible grain in area fills.

The following examples show this defect, the original is on the left, the printed image on the right:
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Scan or copy the diagnostic plot
There are two options for evaluating the diagnostic plot: scanning into a JPEG file, or copying onto paper. 
We recommend using the scan option, so that the generated file can be analyzed more easily by a 
remote support engineer if necessary.

If you decide to scan the plot, first adjust your computer’s monitor as described in Monitor calibration on 
page 149. Once you have scanned the diagnostic plot, remember to open the scanned file in any image 
viewer software and select a zoom of 100% for correct visual evaluation of patterns.

If you decide to copy, make sure that paper is loaded in the printer; the paper should be of the maximum 
width accepted by the printer. Ideally, the same type of paper used to print the diagnostic plot should be 
used for copying it.

These are the settings that you should select:

Scan

● Resolution: 600 dpi

● File type: JPG

● File size: medium

● Paper type: photo or matte, according to the paper used to print the diagnostic plot. Use photo if in 
doubt.

Copy

● Content type: Image

Load the diagnostic plot into the scanner input tray, making sure that the printed side of the plot is 
facing up. The black arrows on the diagnostic plot indicate the direction of loading. Make sure that the 
diagnostic plot is loaded without skew, and it is centered (that is, it covers the whole scanner area).

Once you have scanned the diagnostic plot (in case you selected the scan option), remember to open 
the scanned file in any image viewer software and select a zoom of 100% for correct visual evaluation of 
patterns.

Monitor calibration
The monitor on which the plot is going to be evaluated should ideally be calibrated. As this is not always 
feasible, we propose here to follow an easy procedure for adjusting the brightness and contrast of the 
monitor in order to see the patterns correctly.

Adjust the brightness and contrast of your monitor until you can see a difference in lightness between 
these two squares:
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Now you are ready to check each pattern individually.

Save the diagnostic plot for future use
We recommend saving the diagnostic plot for future use.
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Troubleshooting ink cartridge and 
printhead issues

18

Step by step instructions are provided for you to identify and resolve your issue.

Cannot insert an ink cartridge
It is important that you are using the correct type of cartridge, and that it is well placed in its slot.

1. Check that you have the correct type of cartridge (model number).

2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label 
right-side up and readable.

CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages
There are ink cartridge status messages to alert you to an issue.

● OK: The cartridge is working normally, with no known problems.

● Missing or Damaged: There is no cartridge present, or it is not correctly connected to the printer 
(shown with an X on the status screen).

● Low: The ink level is low.

● Out of ink: The cartridge is empty.

● Not genuine HP: The cartridge is not a genuine HP cartridge.

● Wrong slot: The cartridge has been inserted into the wrong slot.

● Incompatible: The cartridge is incompatible with this printer.

Cannot insert the printhead
It is important that you are using the correct type of printhead, and that it is well placed in its slot.

1. Check that you have the correct type of printhead (model number).
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2. Check that you have removed the orange protective cap from the printhead.

3. Check that the printhead is correctly oriented.

4. Check that you have correctly latched the printhead, see Replace the printhead on page 87.
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Troubleshooting data communication 
issues

19

Step by step instructions are provided for you to identify and resolve your issue.

Communication failures between computer and printer
It is important that the printer is communicating properly to the computer to be able to print.

Symptoms of a communication failure can be:

● The control-panel display does not show the Printing message when you have sent a document to 
the printer.

● Your computer displays an error message when you are trying to print.

● Your computer or printer hangs (stays idle), while communication is taking place.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

How to proceed:

● Ensure that you have selected the correct printer in your application, see Printing on page 35.

● Ensure that the printer works correctly when printing from other applications.

● Remember that very large prints may take some time to receive, process and print.

● If the printer is connected to a network, check the printer connectivity status: the printer should 
have an IP address and it should match the IP address specified in the printing computer. If the 
addresses do not match, then configure it correctly; if the issue persists, check your network 
configuration.

● Try another Ethernet cable.

● If the printer is connected to a wireless network, you can request a diagnostic report from the 
control panel: tap the Menu icon , then Settings > Network > WiFi > WiFi Test Report. Alternatively, 
try moving the printer closer to the wireless router, or try connecting the printer by wired network.

Fixed IP
Set a fixed IP address for the printer from the control panel.

1. Go to the control panel and tap the Menu icon , then > Settings > Network > Wi-Fi or Ethernet.
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2. At the bottom of the screen, tap IPv4 / IPv6 > Manual, and enter the IP address, the subnet mask, 
and the gateway (those settings should be provided by your network administrator).

Hostname
You can use the hostname instead of the numeric IP address.

1. Go to the control panel and tap the Menu icon , then Settings > Network > Wi-Fi/Ethernet details.

2. Take a note of the IP address and the hostname (HPXXXXXX format).

3. If your computer is running Windows, tap the Start button, then the Configuration button, then 
tap Devices > Printers and Scanners, then tap the printer, then Administer > Properties > Ports > 
Configure Port, and in the Printer name or IP address field enter the hostname.

Wired network issues
If you are unable to install the HP software for your printer, then you need to perform some checks to 
solve the issue.

Check that:

● All cable connections to the computer and the printer are secure.

● The network is operational and the network equipment is turned on.

● All applications, including virus protection programs, spyware protection programs, and firewalls, are 
not blocking the connections to the printer.

● The printer is installed on the same subnet as the computers that use the printer.

If the installation program cannot discover the printer, print the network configuration page, and enter 
the IP address manually in the installation program. For more information, see Network configuration 
page on page 158.

Though it is not recommended that you assign a static IP address to the printer, you might resolve 
some installation problems (such as a conflict with a personal firewall) by doing so. See Communication 
failures between computer and printer on page 153.

Network port created does not match printer IP address (Windows)
If you are using a computer running Windows, make sure that the network ports created in the printer 
driver match the printer's IP address.

1. Print the printer’s network configuration page.

2. Click Start, point to Settings, then click Printers or Printers and Faxes.

– or –

Click Start, click Control Panel, then double-click Printers.

3. Right-click the Printer icon, click Properties, and then click the Ports tab.

4. Select the TCP/IP port for the printer, and then click Configure Port.
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5. Compare the IP address listed in the dialog box and make sure it matches the IP address listed 
on the network configuration page. If the IP addresses are different, change the IP address in the 
dialog box to match the address on the network configuration page.

6. Click OK twice to save the settings and close the dialog boxes.

Wireless network issues
Step by step instructions are provided for you to identify and resolve your issue.

Wireless network troubleshooting
Check that the wireless is on, then follow the troubleshooting steps.

1. To turn on wireless, tap the Menu icon , then Settings > Network > Wi-Fi > toggle Wi-Fi to ON.

2. Make sure that an Ethernet cable has not been connected to the printer. Connecting an Ethernet 
cable turns off the printer's wireless capabilities.

3. Restart components of the wireless network.

Turn off the router and the printer, and then turn them back on in this order: router first and then the 
printer. If you still are unable to connect, turn off the router, printer, and your computer. Sometimes, 
turning off the power and then turning it back on can solve a network communication issue.

4. Run the Wireless Network Test.

For wireless networking issues, run the Wireless Network Test. To print a Wireless Network Test 
page, tap the Menu icon , then Settings > Network > Wi-Fi > Wi-Fi Test Report. If a problem is 
detected, the printed test report includes recommendations that could help to solve the problem.

Advanced wireless network troubleshooting
If you have tried to fix the problem and are still unable to connect to your printer to the wireless network, 
then there are steps you can take.

Try the following:

1. Make sure that your computer's wireless networking has been turned on. For more information, see 
the documentation that came with your computer.

2. If you are not using a unique network name (SSID), then it is possible that your computer could be 
connected to a nearby network that is not yours. The following steps can help you to determine 
whether your computer is connected to your network.

Windows:

a. Click Start, click Control Panel, point to Network Connections, then click View Network Status 
and Tasks

– or –

Click Start, then Settings, click Control Panel, double-click Network Connections, click the View 
menu, then select Details.

Leave the network dialog box open while you continue to the next step.
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b. Disconnect the power cord from the wireless router. The connection status of your computer 
should change to Not Connected.

c. Reconnect the power cord to the wireless router. The connection status should change to 
Connected.

Mac OS X:

■ Click the Wi-Fi icon  in the menu bar at the top of the screen. From the menu that appears, 
you can determine if the Wi-Fi is turned on and which wireless network your computer is 
connected to.

TIP: For more detailed information about your Wi-Fi connection, click System Preferences in 
the Dock. If the wireless connection is working correctly, a green dot appears next to the list of 
connections. For more information, click the Help button in the window.

If you are unable to get your computer connected to your network, contact the person/company 
that set up your network or the router manufacturer as there may be a hardware issue with your 
router or computer.

3. Print the printer's Wireless Configuration page (see Network configuration page on page 158). 
After the page has been printed, check the Network Status and URL. The Network Status is Ready 
if the printer is actively connected to a network, or Offline if it is not (in the latter case, run the 
Wireless Network Test). The URL is the network address assigned to the printer by your router; you 
need it to connect to the printer's Embedded Web Server.

4. If you have established that the computer and the printer both have active connections to a 
network, you can check whether they are on the same network by trying to access the printer's 
Embedded Web Server (see Access the Embedded Web Server on page 15).

5. If you cannot access the Embedded Web Server and are sure that both the computer and printer 
have active connections to the same network, the firewall security software could be blocking 
communication. Temporarily turn off any firewall security software running on your computer, and 
try to access the Embedded Web Server again. If you can access it, try using the printer for 
printing.

If you are able to access the Embedded Web Server and use your printer with the firewall 
turned off, you need to reconfigure your firewall settings to allow the computer and printer to 
communicate with each other over the network.

If you are able to access the Embedded Web Server, but are still unable to use the printer even with 
the firewall turned off, try enabling the firewall software to recognize the printer.

6. If you have the HP software installed, you can check the printer’s status from your computer to 
check whether the printer is paused or offline, preventing you from using it.

Windows:

a. Click the Start button, then the Configuration button, then tap Devices > Printers and 
Scanners.

b. Do one of the following, depending on the printer status:

● If the printer is Offline, right-click the printer, and click Use Printer Online.

● If the printer is Paused, right-click the printer, and click Resume Printing.

c. Try using the printer over the network.
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Mac OS X:

a. Click System Preferences in the dock, then click Printers & Scanners.

b. Select the printer, then click Print Queue.

c. If Jobs Stopped appears in the resulting window, click Start Jobs.

Windows:

a. Click the Start button, then the Configuration button, then tap Devices > Printers and 
Scanners.

b. Do one of the following, depending on the printer status:

● If the printer is Offline, right-click the printer, and click Use Printer Online.

● If the printer is Paused, right-click the printer, and click Resume Printing.

c. Try using the printer over the network.

Mac OS X:

a. Click System Preferences in the dock, then click Printers & Scanners.

b. Select the printer, then click Print Queue.

c. If Jobs Stopped appears in the resulting window, click Start Jobs.

7. If you install the HP software a second time, the installer may create a second version of the printer 
driver in your Printers or Printers and Faxes folder (Windows only). If you have difficulties printing or 
connecting to the printer, make sure the correct version of the Windows printer driver is set as the 
default.

a. Click Start, point to Settings, then click Printers or Printers and Faxes.

– or –

Click Start, click Control Panel, then double-click Printers.

b. Right-click the Printer icon, and then click Properties, Document Defaults, or Printing 
Preferences.

c. On the Ports tab, look for a port in the list with a checkmark. The version of the printer driver 
that is connected wirelessly has Standard TCP/IP Port as the Port description, next to the 
checkmark.

d. Right-click the Printer icon for the version of the printer driver that is connected wirelessly, and 
click Set as Default Printer.

8. Try restarting the HP Network Device Support service (Windows only).

a. Delete any print jobs currently in the print queue.

b. On the desktop, right-click My Computer or Computer, then click Manage.

c. Double-click Services and Applications, then click Services.

d. Scroll down the list of services, right-click HP Network Devices Support, then click Restart

e. After the service restarts, try using the printer over the network again.
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If you are able to use the printer over the network, your network setup was successful.

If you still cannot use the printer over the network, or if you have periodic problems in doing so, your 
firewall may be interfering, or there may be a problem with your network configuration or router. Contact 
the person who set up your network or the router manufacturer for help.

Add hardware addresses to a wireless access point (WAP)
MAC filtering is a security feature in which a WAP is configured with a list of MAC addresses (also called 
“hardware addresses”) of devices that are allowed to gain access to the network through the WAP.

If the WAP does not have the hardware address of a device attempting to access the network, the WAP 
denies the device access to the network. If the WAP filters MAC addresses, then the printer’s MAC 
address must be added to the WAP’s list of accepted MAC addresses.

1. Print the network configuration page. For more information, see Network configuration page on 
page 158.

2. Open the WAP’s configuration utility, and add the printer’s hardware address to the list of accepted 
MAC addresses.

Mobile Printing issues
For issues, visit the links listed here.

See the HP website at the following link: http://www.hp.com/go/designjetmobility (availability varies by 
product, country, and region).

Also see the HP website at the following link: http://www.hpsmart.com.

Network configuration page
If the printer is connected to a network, you can print a network configuration page to view the network 
settings for the printer.

You can use the network configuration page to help troubleshoot network connectivity problems. If you 
need to call HP, it is often useful to print this page before calling. To print the network configuration 
page from the control panel: tap the Menu icon , then > Tools > Reports > Status Reports > Network 
Configuration Report.

1. General Information: Shows information about the current status and active connection type of the 
network, and other information, such as the URL of the Embedded Web Server.
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2. 802.3 Wired: Shows information about the active wired network connection, such as the IP address, 
subnet mask, default gateway, and hardware address of the printer.

3. 802.11 Wireless: Shows information about your wireless network connection, such as the hostname, 
IP address, subnet mask, default gateway, and server.

4. Miscellaneous: Shows information about more advanced network settings.

● Port 9100: The printer supports raw IP printing through TCP Port 9100. This HP-proprietary 
TCP/IP port on the printer is the default port for printing. It is accessed by HP software (for 
example, the HP Standard Port).

● LPD: Line Printer Daemon (LPD) refers to the protocol and programs associated with line-printer 
spooling services that may be installed on various TCP/IP systems.

NOTE: The LPD functionality can be used with any host implementation of LPD that complies 
with the RFC 1179 document. The process for configuring printer spoolers, however, might 
differ. See your system documentation for information about configuring these systems.

● Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name System) are typically 
used on small networks for IP address and name resolution (through UDP port 5353), where a 
conventional DNS server is not used.

● SLP: Service Location Protocol (SLP) is an Internet standard network protocol that provides 
a framework to allow networking applications to discover the existence, location, and 
configuration of networked services in enterprise networks. This protocol simplifies discovery 
and use of network resources such as printers, Web servers, fax machines, video cameras, file 
systems, backup devices (tape drives), databases, directories, mail servers, and calendars.

● Microsoft Web Services: Enable or disable the Microsoft Web Services Dynamic Discovery 
(WS Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services 
supported on the printer. Disable unused print services to prevent access through those 
services.

NOTE: For more information about WS Discovery and WSD Print, visit the Microsoft website 
at the following link: http://www.microsoft.com/.

● SNMP: SNMP (Simple Network Management Protocol) is used by network management 
applications for device management. The printer supports SNMPv1 protocol on IP networks.

● WINS: If you have a Dynamic Host Configuration Protocol (DHCP) server on your network, the 
printer automatically obtains its IP address from that server and registers its name with any 
RFC 1001 and 1002-compliant dynamic name services as long as a WINS server IP address has 
been specified.

5. Connected PC(s): Lists the computers connected to this printer, as well as the last time these 
computers accessed the printer.
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Troubleshooting general printer issues20

Step by step instructions are provided for you to identify and resolve your issue.

Printer does not start
You may have an electrical power problem. If there is no activity at all from the printer and the control 
panel does not respond, check that the power cord is connected correctly and that there is power 
available at the socket.

● If the printer does not start (the control panel is blank), hold down the Power key for a few seconds 
and check whether the power LED turns orange while the key is held down.

● If you see no orange light, no power is reaching the printer; check that the power cord is correctly 
plugged in. If the problem persists, call HP Support (see HP Customer Care on page 168) and explain 
that you have a problem with the power supply.

● If you see the orange light, wait for the printer to check if it makes a beeping sound:

● Three beeps means an electronic problem; call HP Support and explain.

Printer does not print
If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why 
a file you have sent from your computer may not start printing when expected:

● You may not have installed in your computer the correct driver for your printer.

● If you are printing on a sheet, you must specify Automatic or Sheet as the paper source in your 
printer driver.

● Check the complexity of the job, very large prints may take some time to receive, process and print.

● You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic 
fields or severe electrical disturbances, which can cause the printer to behave strangely or even 
stop working. In this case, turn off the printer using the Power key at the back and unplug the power 
cord, wait until the electromagnetic environment has returned to normal, then turn it on again. If you 
still experience problems, contact your customer service representative.

Printer seems slow
Here are some possible explanations:
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● Did you set the print-quality to Best or Maximum detail? Best-quality and maximum detail prints take 
longer.

● Did you specify the correct paper type when loading the paper? Some paper types require more 
time for printing; for example, photo and coated papers require more drying time between passes. To 
find out the printer's current paper type setting, see View information about the paper on page 32.

● If your printer is connected by network, check that all components used in the network (network 
interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of 
traffic from other devices on the network?

● Did you specify Extended drying time in the control panel? Try changing the drying time to Optimal.

● If your printer is connected by Wi-Fi, switch to a wired network.

Control panel is frozen
If the control panel displays a fixed image and you are unable to use it, power cycle your printer.

● Turn off the printer and unplug the power cord from it.

● Wait 30 seconds.

● Plug the power cord into the printer again and turn the printer on.

● Check the functionality of the printer.

If the problem persists, call HP support. See HP Customer Care on page 168.

Cannot access the Embedded Web Server
If you are using a proxy server, try bypassing the server and accessing the Embedded Web Server 
directly.

Before proceeding, if you have not done so already, please read: Access the Embedded Web Server on 
page 15.

● In Microsoft Edge for Windows, go to Tools > Internet Options > Connections > LAN Settings, and 
check the Bypass proxy server for local addresses box. Alternatively, for more precise control, click 
the Advanced button and add the printer's IP address to the list of exceptions, for which the proxy 
server is not used.

● In Safari for Mac OS X, go to Safari > Preferences > Advanced and click the Proxies: Change Settings 
button. Add the printer's IP address or its domain name to the list of exceptions, for which the proxy 
server is not used, in the bypass proxy settings for the Hosts & Domains field.

If you still cannot connect, switch the printer off and back on with the Power key on the control panel.

Restore factory defaults and settings
If you disabled any functions or changed some settings and want to change them back, you can restore 
the printer to the original factory settings or network settings.

Defaults
Restore the printer to the original factory defaults.
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1. From the control panel, tap Menu > Tools > Maintenance > Restore Settings, then select the 
appropriate reset option: Restore Network Settings, Restore User Settings, Restore User Data, or 
Restore All Factory Defaults.

2. From the Embedded Web Server, open the General tab, then Restore Default Settings, then select 
the appropriate reset option: Restore Network Settings or Restore All Factory Defaults.

3. Restore All Factory Defaults. Tap Restore to reset all printer settings. All configured settings in the 
printer will be deleted and the original factory settings will be restored, including all administrator 
passwords for the printer, network configurations, any stored jobs (if available), HP workpath 
licenses (if available), contact entries (for scan and fax), and web services account information.

Alerts
Your printer can report errors or alerts in different ways.

● Errors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the 
printer driver, errors can also alert you to conditions that could ruin the print, such as clipping, even 
if the printer is able to print.

● Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration 
or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer's system:

● Control-panel display: The control panel shows only the most relevant alert at a time. In the case of 
a warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on 
ink", that reappear when the printer becomes idle and there is not another more severe alert.

● Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the 
printer status. If there is an alert in the printer, the status shows the alert text.

● Print queue: The print queue shows alerts. The driver warns about job configuration settings that 
may produce a problem in the final output. If the printer is not ready to print, it displays a warning.

By default, error alerts (critical alerts) are always displayed and warning alerts (non-critical alerts) as 
displayed only when you are printing. If alerts are enabled and there is a problem that prevents a 
job from completing, you see a pop-up window, which explains the reason for the problem. Follow the 
instructions to achieve your required result.

NOTE: There are environments that do not support bidirectional communication. In those cases, 
alerts do not reach the job owner.
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Control-panel error messages21

Printer issues appear in the control panel automatically along with the recommendation of how to fix 
them.

Text messages and numerical error codes
Error messages indicate that there is a printer error that needs attention. When they appear, follow the 
advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct 
response, or if the recommended action does not seem to solve the problem, contact HP Support. See 
Contact HP Support on page 170.

Text messages

Message Recommendation

Cartridge low The indicated cartridges are low. You do not have to replace the cartridge(s) now. HP 
recommends you have a replacement available for when the cartridge is depleted and will 
need to be replaced.

Cartridge very low The indicated cartridges are very low and will be depleted soon. While you do not have to 
replace the cartridges now, HP recommends you have a replacement available for when 
cartridges are depleted and will need to be replaced.

Cartridges depleted The indicated cartridges are depleted. Replace these cartridges.

Maintenance kit 1 required Contact HP Support. See Contact HP Support on page 170.

Maintenance kit 2 required Contact HP Support. See Contact HP Support on page 170.

Cartridge Problem Insert cartridges of the correct color as needed. See Replace an ink cartridge on page 83.

Carriage jam See Roll has jammed on page 106 or Tray has jammed (HP DesignJet T850) on page 107 or 
Tray has jammed (HP DesignJet T950) on page 108.

The width of the paper is smaller 
than the minimum size supported 
by the selected media source. 
Loading canceled.

Remove the paper and load paper of the correct size.

Loaded paper is too wide. Manual 
unload required.

Remove the paper manually and load paper of the correct size.

The paper is too far from the 
lateral load line. Try loading the 
paper again.

Remove and reload the paper.

Please manually unload roll paper 
and try again.

Rewind the roll manually.

Control-panel error messages 163



Text messages (continued)

Message Recommendation

The currently loaded paper has 
too much skew and cannot 
be corrected automatically. Tap 
Remove, and then load the paper 
again.

Remove and reload the paper.

The roll is out of paper, and the 
current job has been canceled. 
Load another roll, and then send 
the job again.

Load a new roll.

You are printing a multipage job. 
Load another sheet to continue 
printing or cancel the job.

Load another single sheet.

Tray is out of paper. Load paper in 
the tray and press OK to continue 
printing or cancel the job.

Load paper into the tray.

End of roll has been reached. It is 
not possible to load the roll.

Load a new roll.

Missing or failed printhead. Remove and reinsert the same printhead, or try cleaning the electrical connections. If 
necessary, insert a new printhead. See Replace the printhead on page 87.

NOTE: The error message does not permit returning to the home screen to start the 
printhead replacement. Instead, press Show more.

Refilled or depleted cartridge 
detected

Check the cartridge.

Used cartridges might not have 
enough ink to complete start-up. 
Open ink door to replace the 
cartridges.

A new printhead has been inserted without a new set of ink cartridges. Replace the 
cartridges not marked as new. See Replace an ink cartridge on page 83.

Reading a system error code

System error codes explain what action should be taken to resolve the problem. They are defined in 
two ways: D0XX-YYZZ, which explains which component or system is failing, or xx.xx.xx.xx. Both formats 
indicate the course of action to be taken.

The first format is explained in the following table. The second format (xx.xx.xx.xx) occurs in response 
to internal firmware failures. In this case, you should restart the printer, then ensure that you have the 
latest firmware version: updating it may solve the problem. If the problem persists, contact your service 
representative. Some examples of these errors are F0.01.01.02, F0.01.04.07, F0.01.01.04 or F0.01.01.01.

For System Errors in format D0XX-YYZZ, the different parts of the code have the following meanings:

● D: Device information in which the failure has been detected.

● XX: Subsystem in which the failure has been detected (see the subsystem error codes table)

● YY: Service part in which the failure has been detected.

● ZZ: Indicates the cause of error as identified by self-diagnostics; see the next section for more 
details.

Values of D (Device)
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Value Subsystem

0 Printer

1 Accessories

8 Internal printer firmware error*

*Errors starting with 8 (D=8) are internal firmware issues (for example, 86B0-1A7E-0000). If an error of 
this kind appears, there is probably an issue in the firmware that will be solved in a future release. These 
errors are not documented for this reason. If one of these errors appears, check whether the latest 
firmware is installed and install it if needed.

Values of XX (subsystem)

Value Subsystem

01 Main PCA

04 Print Bundle PCA

09 Scanner

21 Service Station

26 Ink supply station

27 Printhead

41 Carriage PCA

42 Carriage Motor

43 Pick Motor

44 Feed Motor

45 Rewinder Motor

59 NVM

85 Feed Index PCA

87 Encoder

For system errors in the XX.YY.XX.XX format, YY indicates the subsystem.

Value YY

01 System

02 Security

03 Connectivity

04 Front panel firmware

31 Job management
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Numerical error codes

Error code Recommendation

0009-0101 Scanner issue. To continue using the scanner, restart 
the printer. If the problem persists, call your support 
representative.

0009-0301 Scanner issue. To continue using the scanner, restart 
the printer. If the problem persists, call your support 
representative.

0009-0401 Scanner issue. To continue using the scanner, restart 
the printer. If the problem persists, call your support 
representative.

0009-0501 Scanner issue. To continue using the scanner, restart 
the printer. If the problem persists, call your support 
representative.

0009-0259 Scanner Motor error. There may be a paper or carriage jam. 
Check and clear the paper path if necessary and restart the 
printer.

0021-0060 Service station error. There may be a paper or carriage jam. 
Check and clear the paper path if necessary and restart the 
printer.

0026-0061 ISS Pump error. Call your support representative.

0042-0059 Carriage Motor error. There may be a paper or carriage jam. 
Check and clear the paper path if necessary and restart the 
printer.

0042-0060 Carriage Motor error. There may be a paper or carriage jam. 
Check and clear the paper path if necessary and restart the 
printer.

0043-0059 Pick motor error. There may be a paper or carriage jam. Check 
and clear the paper path if necessary and restart the printer.

0043-0060 Pick motor error. There may be a paper or carriage jam. Check 
and clear the paper path if necessary and restart the printer.

0044-0059 Feed motor error. There may be a paper or carriage jam. 
Check and clear the paper path if necessary and restart the 
printer.

0044-0060 Feed motor error. There may be a paper or carriage jam. 
Check and clear the paper path if necessary and restart the 
printer.

0045-0060 Rewinder motor error. There may be a paper or carriage jam. 
Check and clear the paper path if necessary and restart the 
printer.

0721-0078 PMK maintenance needed. Call your support representative.

0955-0050 Line sensor error. Call your support representative.

F0.01.01.01 Internal FW error. Make sure that the printer firmware version 
is up to date and restart the printer.

F0.01.01.02 Internal FW error. Make sure that the printer firmware version 
is up to date and restart the printer.

F0.01.01.04 Internal FW error. Make sure that the printer firmware version 
is up to date and restart the printer.
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Numerical error codes (continued)

Error code Recommendation

F0.01.04.07 Internal FW error. Make sure that the printer firmware version 
is up to date and restart the printer.

F0.01.01.06 Make sure that the printer firmware version is up to date and 
restart the printer.

F0.01.04.03 Make sure that the printer firmware version is up to date and 
restart the printer.

F0.01.03.01 Make sure that the printer firmware version is up to date and 
restart the printer.

F0.01.03.04 Make sure that the printer firmware version is up to date and 
restart the printer.

8XXX-XXXX Internal FW error. Make sure that the printer firmware version 
is up to date and restart the printer.
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HP Customer Care22

HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, 
providing comprehensive, proven support expertise and new technologies to give you unique end-to-end 
support.

Introduction
Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange 
services, phone and Web support, software updates and self-maintenance services.

To find out more about HP Customer Care, see Contact HP Support on page 170.

To register your warranty, visit the HP website at the following link: https://eoi.hpcloud.hp.com/login.

HP Professional Services
Enjoy a world of dedicated services and resources to ensure you always get the best performance from 
your HP DesignJet printers and solutions.

HP Support Center
Join the HP community at the HP Support Center, your large-format printing community, for 24×7 access 
to support.

● Multimedia tutorials

● Step-by-step how-to guides

● Downloads: the latest printer firmware, drivers, software, paper presets, etc.

● Technical support: online troubleshooting, customer care contacts and more

● Workflows and detailed advice for completing various printing tasks from particular software 
applications

● Forums for direct contact with the experts, both HP and your colleagues

● Warranty tracking online, for your peace of mind

● Latest product information: printers, supplies, accessories, software, etc.

● Supplies Center for all you need to know about ink and paper
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The HP Support Center can be found on the HP website at the following link (depending on printer 
model):

● HP DesignJet T850: https://www.hp.com/go/DesignJetT850/support

● HP DesignJet T850MFP: https://www.hp.com/go/DesignJetT850MFP/support

● HP DesignJet T950: https://www.hp.com/go/DesignJetT950/support

● HP DesignJet T950MFP: https://www.hp.com/go/DesignJetT950MFP/support

By customizing your registration for the products you have purchased and your type of business, and by 
setting your communication preferences, you decide the information you need.

Download printer software
Be sure to follow the software installation instructions.

Install the printer software from the HP website at the following link (depending on printer model):

● HP DesignJet T850: https://www.hp.com/go/DesignJetT850/software

● HP DesignJet T850MFP: https://www.hp.com/go/DesignJetT850MFP/software

● HP DesignJet T950: https://www.hp.com/go/DesignJetT950/software

● HP DesignJet T950MFP: https://www.hp.com/go/DesignJetT950MFP/software

HP Care Packs and Warranty Extensions
HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the 
standard period.

They include remote support. On-site service is also provided if necessary, with two alternative 
response-time options:

● Next business day

● Same business day, within four hours (may not be available in all countries)

There is an HP Installation service that unpacks, sets up, and connects the printer for you.

For more information on HP Care Packs, visit the HP website at the following link: 
http://cpc.ext.hp.com/portal/site/cpc.

Customer Self Repair
HP's Customer Self Repair program offers our customers the fastest service under either warranty or 
contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace 
them.

Using this program, you can replace parts at your own convenience.

Convenient, easy to use

● An HP Support Specialist will diagnose and assess whether a replacement part is required to 
address a defective hardware component.
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● Replacement parts are express-shipped; most in-stock parts are shipped the very same day you 
contact HP.

● Available for most HP products currently under warranty or contract.

● Available in most countries.

For more information about Customer Self Repair, visit the HP website at the following link: 
http://www.hp.com/go/selfrepair.

Contact HP Support
HP Virtual Assistant is there to provide you with support at any time day or night.

You can access the HP Virtual Assistant for your printer from the HP website at the following link: 
https://www.hp.com/go/DesignJet/VA.

HP Support is also available to you by telephone. What to do before you call:

● Review the troubleshooting suggestions in this guide.

● Review the relevant driver documentation.

● If you have installed third-party software drivers and RIPs, see their documentation.

● If you call one of the HP offices, please have the following information available to help us answer 
your questions more quickly:

– The product you are using (the product number and the serial number, found on the label at the 
back of the product)

– If there is an error code on the control panel, note it down; see Text messages and numerical 
error codes on page 163

– The computer you are using

– Any special equipment or software you are using (for example, spoolers, networks, switch-boxes, 
modems or special software drivers)

– The type of interface used on your product (USB, network, or Wi-Fi)

– The software and driver name and version number that you are currently using

– The Printer Service information:

○ From the Embedded Web Server:

In a Web browser, enter your printer's IP address to access the Embedded Web Server. To 
access the printer's service information:

Tap Support Tools > Service Support > Service Information > , then tap the Download button
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Reports and Pages Shown and Service Information will be automatically checked.

Tap the Download button. Wait until the printer has finished generating the report file.

NOTE: When you access these pages, the printer asks you to sign in with the PIN. See 
Access the Embedded Web Server on page 15.
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Printer specifications23

Reference lists of physical, technical, ecological, etc. specifications for your printer.

Functional specifications
Your printer is designed to deliver CAD / construction drawings as well as high quality graphics.

HP ink supplies

Description Specification

Printhead One printhead

Ink cartridges Cartridges containing 130 ml of ink: black, yellow, magenta, and cyan

Cartridges containing 300 ml of ink: black, yellow, magenta, and cyan

Paper sizes

Description Minimum Maximum

Roll width 368 mm (14.5 in) 914 mm (36 in)

Roll length N/A HP DesignJet T850: 46 m (150 feet)

HP DesignJet T950: 91 m (300 feet)

Roll diameter N/A HP DesignJet T850: 100 mm (3.9 in)

HP DesignJet T950: 140 mm (5.5 in)

Roll weight N/A HP DesignJet T850: 6 kg (13.2 lb)

HP DesignJet T950: 13 kg (28.6 lb)

Sheet width 210 mm (8.27 in) 914 mm (36 in)

Sheet length 279 mm (11 in) 1676 mm (66 in)

Paper thickness N/A 0.3 mm (0.01 in)

Paper weight – roll/manual sheet 60 g/m² 280 g/m²

Paper weight – multi-sheet tray HP DesignJet T850: 60 
g/m²

HP DesignJet T950: 64 
g/m²

HP DesignJet T850: 220 g/m²

HP DesignJet T950: 250 g/m²
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Printing resolutions

Print quality Maximum detail Rendering resolution (ppi) Printing resolution (dpi)

Best (glossy paper*) On

Off

1200 × 1200

600 × 600

2400 × 1200

1200 × 1200

Best (other papers) Off 600 × 600 1200 × 1200

Normal Off 600 × 600 1200 × 1200

Fast Off 600 × 600 1200 × 1200

Econofast Off 600 × 600 1200 × 1200

* For a list of supported glossy papers, see Order paper on page 100.

Margins

Description Specification

Top left and right margins 5 mm (0.2 in)

Bottom margin 17 mm (0.67 in) (manual sheet)

Mechanical accuracy

Specifications

±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/A0 printing 
material in Best or Normal mode with HP Heavyweight Coated Paper roll feed.

Graphic languages supported

HP DesignJet Languages

HP DesignJet T850/
T950

HP PCL3GUI, HP-GL/2, PDF (on HP DesignJet T950 and HP DesignJet T850 MFP units)

Physical specifications
Printer models have both common and distinct specifications.

Printer physical specifications

Specificati
on

HP DesignJet T850 HP DesignJet T850MFP HP DesignJet T950 HP DesignJet T950MFP

Weight 47 kg (104.5 lb) (w/o paper 
roll)

60 kg (130.1 lb) (w/o paper 
roll)

56 kg (124.8 lb) (w/o paper 
roll)

71 kg (156.5 lb) (w/o paper 
roll)

Width 1407 mm (55.4 in) 1407 mm (55.4 in) 1407 mm (55.4 in) 1407 mm (55.4 in)

Depth 914 mm (36 in) (output bin 
extended)

701 mm (27.6 in) (output bin 
closed)

914 mm (36 in) (output bin 
extended)

701 mm (27.6) (output bin 
closed)

988 mm (38.9 in) (soft 
stacker extended)

720 mm (28.3 in) (soft 
stacker closed)

988 mm (38.9 in) (soft 
stacker extended)

720 mm (28.3 in) (soft 
stacker closed)
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Printer physical specifications (continued)

Specificati
on

HP DesignJet T850 HP DesignJet T850MFP HP DesignJet T950 HP DesignJet T950MFP

Height 967 mm (38 in) 967 mm (38.1 in) 967 mm (38 in) 967 mm (38.1 in)

Memory specifications
Your printer has 1 GB of memory.

Memory specifications

Printer Memory

HP DesignJet T850/T950 1 GB

Power specifications
Use the electrical cord supplied with the printer and the power supply voltage specified on the label. 
Avoid overloading the printer's electrical outlet with multiple devices.

Printer power specifications

Type: Values:

Source 100–240 V ac ∓10%, auto-ranging

Frequency 50/60 Hz

Maximum current 1200 mA

Average consumption 35 W

Ecological specifications
This product complies with the WEEE Directive 2012/19/EU and RoHS Directive 2011/65/EU.

To determine the ENERGY STAR and EPEAT registration status of these 
product models, check your model at the following links: http://www.epeat.net and 
http://www.energystar.gov/productfinder or see the HP website at the following link: 
https://www.hp.com/us-en/hp-information/sustainable-impact/document-reports.html.

Inks are UL ECOLOGO® certified. For more information, visit the following link: 
http://www.spot.ul.com/main-app/products/catalog/

Printer models made with a minimum of 35% post-consumer recycled plastic by total plastic weight.

Free, convenient HP ink cartridge recycling with HP Planet Partners program. Program availability varies. 
Please check the HP website at the following link for details: http://www.hp.com/recycle.

The new scheduler feature enables to significantly save energy when the printer is idle.

For every page you print, HP protects, restores and manages forests. HP works collaboratively with our 
partners including WWF and Conservation International to manage, restore, and protect forests in many 
countries around the world. With HP, every print—regardless of paper brand—is addressed through HP’s 
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Forest Positive Framework to counteract risks of deforestation. To learn more visit the HP website at the 
following link: http://hp.com/forestfirst

Environmental specifications
Recommended operating and storage temperature and humidity.

Printer environmental specifications

Type: Values:

Operating temperature 5 to 40 degree Celsius (41 to 104 degree Fahrenheit)

Recommended operating temperature 15 to 35 degree Celsius (59 to 95 degree Fahrenheit), 
depending on paper type

Storage temperature –25 to 55 degree Celsius (–13 to 131 degree Fahrenheit)

Recommended operating humidity 20 to 80% RH, depending on paper type

Storage humidity 0 to 95% RH

Maximum altitude when printing 3000 m (9843 ft)

Acoustic specifications
Declared noise emission levels for the HP DesignJet T850/T950 Printer Series. Sound pressure levels at 
bystander positions and sound power levels measured per ISO 7779.

Printer acoustic specifications

Description Specification

Idle sound power < 3.4 B (A)

Operating sound power 5.8 B (A)

Idle sound pressure < 16 dB (A)

Operating sound pressure 42 dB (A)
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Glossary

 AirPrint  
Apple technology that helps you create full-quality printed output without the need to download or install 
drivers.

Bonjour  
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a 
computer network technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover 
services available on a local area network. It was originally known as Rendezvous.

Color accuracy  
The ability to print colors that match the original image as closely as possible, bearing in mind that 
all devices have a limited color gamut and may not be physically capable of matching certain colors 
precisely.

Color consistency  
The ability to print the same colors from a particular print job from print to print and from printer to 
printer.

Color model  
A system of representing colors by numbers, such as RGB or CMYK.

Color space  
A color model in which each color is represented by a specific set of numbers. Many different color 
spaces can use the same color model: for instance, monitors generally use the RGB color model, but 
they have different color spaces, because a particular set of RGB numbers results in different colors on 
different monitors.

Cutter  
A printer component that slides back and forth across the platen to cut the paper.
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ESD  
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the 
car door, or the cling of clothing. Although controlled static electricity has some useful applications, 
uncontrolled electrostatic discharges are one of the main hazards to electronic products. Therefore, to 
prevent damage some precautions are needed when setting up the printer, or handling ESD sensitive 
devices. This type of damage may reduce the life expectancy of the device. One way to minimize 
uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded 
part of the printer (mainly metal parts) before handling ESD sensitive devices (such as the printhead or 
ink cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid 
working in a carpeted area, and keep your body movements to a minimum when handling ESD sensitive 
devices. Also, avoid working in low humidity environments.

Ethernet  
A popular computer networking technology for local area networks.

Fast Ethernet  
An Ethernet network capable of transferring data at up to 100,000,000 bits/second. Fast Ethernet 
interfaces are capable of negotiating slower speeds when required for compatibility with older Ethernet 
devices.

Firmware  
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can 
be updated).

Gamut  
The range of colors and density values reproducible on an output device, such as a printer or monitor.

HP RTL  
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

HP-GL/2  
HP Graphics Language 2: a language defined by HP to describe vector graphics.

I/O  
Input/Output: this term describes the passing of data between one device and another.

ICC  
The International Color Consortium, a group of companies that have agreed on a common standard for 
color profiles.

Ink cartridge  
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address  
May mean an IPv4 address (most likely) or an IPv6 address.

IPv4 address  
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four 
integers separated by full stops. Most networks in the world use IPv4 addresses.
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IPv6 address  
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up 
to 8 groups of hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. 
Only a few new networks in the world use IPv6 addresses.

LED  
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address  
Media Access Control address: a unique identifier used to identify a particular device on a network. It 
is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP 
address.

Network  
A network is a set of connections that pass data between computers and devices. Every device is able 
to communicate with every other device in the same network. This allows data to be moved between 
computers and devices, and allows devices such as printers to be shared between many computers.

Nozzle  
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper  
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind 
which are pulped, dried and pressed.

Platen  
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver  
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead  
A removable printer component that takes ink of one or more colors from the corresponding ink 
cartridge(s) and deposits it on the paper, through a cluster of nozzles.

Spindle  
A rod that supports a roll of paper while it is being used for printing.

TCP/IP  
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is 
based.

USB  
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your printer 
supports Hi-Speed USB (sometimes called USB 2.0).

USB host port  
A rectangular USB socket such as those on found on computers. A printer can control USB devices that 
are connected to such a port.
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WiFi  
This term is used for any wireless local area network products that are based on the Institute of 
Electrical and Electronics Engineers' (IEEE) 802.11 standards.
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